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The software contained in this product makes use of several valuable open source software packages. For information, see the
"Open Source Acknowledgement" document, which is available for download from the R&S AMU product page at http://www.rohde-
schwarz.com/product/AMU200A.html > "Downloads" > "Firmware".

Rohde & Schwarz would like to thank the open source community for their valuable contribution to embedded computing.
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Phone: +49894129-0
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Subject to change — Data without tolerance limits is not binding.
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Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®AMU200A is abbreviated as R&S AMU, R&S®WinIQSIM2™ is
abbreviated as R&S WinlQSIM2.
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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully
complying with safety standards. To maintain this condition and to ensure safe operation, you must
observe all instructions and warnings provided in this manual. If you have any questions regarding these
safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product"” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and dangers.

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF Power

Observe product documentation

Caution when handling heavy equipment d) Standby indication

Danger of electric shock f— Direct current (DC)

> B>

1171.0000.42 - 08 Page 1



Basic Safety Instructions

Meaning Symbol Meaning
Caution ! Hot surface ~_ Alternating current (AC)
Protective conductor terminal = Direct/alternating current (DC/AC)
To identify any terminal which is intended for
connection to an external conductor for
protection against electric shock in case of a
fault, or the terminal of a protective earth
Earth (Ground) D Class Il Equipment
to identify equipment meeting the safety

requirements specified for Class Il equipment
(device protected by double or reinforced
insulation)

Frame or chassis Ground terminal

EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection”, item 1.

devices

Be careful when handling electrostatic sensitive

EU labeling for separate collection of electrical
and electronic devices

For additional information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks

and dangers.

& WARNING

A CAUTION

Indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

Indicates information considered important, but not hazard-related, e.g.
messages relating to property damage.
In the product documentation, the word ATTENTION is used synonymously.

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution degree 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the mains, or if the power switch is not
suitable for this purpose, use the plug of the connecting cable to disconnect the product from the
mains. In such cases, always ensure that the power plug is easily reachable and accessible at all
times. For example, if the power plug is the disconnecting device, the length of the connecting cable
must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection
from the AC supply network. If products without power switches are integrated into racks or systems,
the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that
apply in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.qg. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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2. Before you move or transport the product, read and observe the section titled "Transport".

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

5. Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

7. Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22,

EN 55032/CISPR 32)

— Class A equipment:
Equipment suitable for use in all environments except residential environments and environments
that are directly connected to a low-voltage supply network that supplies residential buildings
Note: Class A equipment is intended for use in an industrial environment. This equipment may
cause radio disturbances in residential environments, due to possible conducted as well as
radiated disturbances. In this case, the operator may be required to take appropriate measures to
eliminate these disturbances.

— Class B equipment:
Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings

Repair and service

1. The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.
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Basic Safety Instructions

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

1171.0000.42 - 08 Page 6



Instrucciones de seguridad elementales

Waste disposal/Environmental protection

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de seguridad.
Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario debera
atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas
Rohde & Schwarz esta siempre a su disposicién en caso de que tengan preguntas referentes a estas
informaciones de seguridad.

Ademés queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacién, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacién del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccion de personas, que encontrardn en el capitulo correspondiente de la
documentacién del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacién del producto.

Sefializacién de seguridad de los productos

Las siguientes sefiales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros.

Simbolo Significado Simbolo Significado

Aviso: punto de peligro general | O Tension de alimentacion de PUESTA EN

o, MARCHA / PARADA
Observar la documentacion del producto

Atencién en el manejo de dispositivos de peso d) Indicacion de estado de espera (standby)
A elevado
| 18 kg |
2 Peligro de choque eléctrico e Corriente continua (DC)
f Advertencia: superficie caliente A~ Corriente alterna (AC)
. Conexion a conductor de proteccion —_ Corriente continua / Corriente alterna (DC/AC)
Conexion a tierra D El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)
Conexi6n a masa Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente",
punto 1.
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Instrucciones de seguridad elementales

Simbolo Significado Significado

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostatica (ESD)

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electronicos

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente”,
punto 2.

Advertencia: rayo laser

Mas informacion en la seccién
"Funcionamiento", punto 7.

Palabras de sefial y su significado

En la documentacidon del producto se utilizan las siguientes palabras de sefial con el fin de advertir contra
riesgos y peligros.

A PELIGRO Indica una situacion de peligro que, si no se evita, causa lesiones
graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar

A ADVERTENCIA lesiones graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar
lesiones leves o moderadas.

A ATENCION

m Indica informacién que se considera importante, pero no en relacion
con situaciones de peligro; p. €j., avisos sobre posibles dafios
materiales.

En la documentacion del producto se emplea de forma sindénima el
término CUIDADO.

Las palabras de sefial corresponden a la definicion habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicién en otras areas econémicas o
en aplicaciones militares. Por eso se deberd tener en cuenta que las palabras de sefial aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacién del producto y
solamente en combinacion con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.
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Instrucciones de seguridad elementales

Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicién de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccién IP 2X, uso solamente en estancias interiores, utilizacién hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No sitle el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacion del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se deberd comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion mévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcién intencionada del conductor de proteccién, tanto en la toma de
corriente como en el mismo producto. La interrupcion puede tener como consecuencia el riesgo de
gue el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacién de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no est& equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexién se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €]., el enchufe de conexion a la red es el dispositivo de desconexién, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electrénicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccién y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser dafiado o de que nadie
pueda ser dafiado por él, p. €j. al tropezar o por un choque eléctrico.

1171.0000.42 - 08 Page 10



10.

11.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizacién de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tension Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacion
de tensidn, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafos en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexién. La instalacion y
la conexidon deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafios.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacién contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. €j. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ninglin concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacién/proteccion del medio ambiente”, punto 1.

Ciertos productos, como p. €]. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacion de evaluar y sefalizar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafios a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcién de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo biolégico a causa de
las propiedades de su radiacion y debido a su concentracién extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcion aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. ej. debidas a irradiacion laser).

Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogia con EN

55022 / CISPR 22, EN 55032 / CISPR 32)

— Aparato de clase A:
Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos
conectados directamente a una red de distribucion de baja tensiéon que suministra corriente a
edificios residenciales.
Nota: Los aparatos de clase A estan destinados al uso en entornos industriales. Estos aparatos
pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles
perturbaciones guiadas o radiadas. En este caso, se le podra solicitar al operador que tome las
medidas adecuadas para eliminar estas perturbaciones.

— Aparato de clase B:
Aparato adecuado para su uso en entornos residenciales, asi como en aquellos conectados
directamente a una red de distribucién de baja tension que suministra corriente a edificios
residenciales.
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Instrucciones de seguridad elementales

Reparacion y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccién, medicién de resistencia de aislamiento, medicion de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. €j. celdas de
litio) debe seqguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafio seco y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevacion adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.
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Instrucciones de seguridad elementales

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafios personales o
dafos en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafios.

Eliminacién/protecciéon del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencién al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacién de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencion
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecéanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacién adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.

Se puede encontrar mas informacion sobre la proteccién del medio ambiente en la pagina web de
Rohde & Schwarz.
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Quality management
and environmental

management

Sehr geehrter Kunde,

Sie haben sich fur den Kauf
eines Rohde & Schwarz Produk-
tes entschieden. Sie erhalten
damit ein nach modernsten Fer-
tigungsmethoden hergestelltes
Produkt. Es wurde nach den
Regeln unserer Qualitats- und
Umweltmanagementsysteme
entwickelt, gefertigt und gepruft.
Rohde & Schwarz ist unter ande-
rem nach den Managementsys-
temen ISO90071 und ISO 14001
zertifiziert.

Der Umwelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche
Weiterentwicklung nachhaltiger
Umweltkonzepte

1 ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear customer,

You have decided to buy a
Rohde & Schwarz product. This
product has been manufactured
using the most advanced meth-
ods. It was developed, manufac-
tured and tested in compliance
with our quality management
and environmental manage-
ment systems. Rohde & Schwarz
has been certified, for exam-
ple, according to the ISO 9001
and ISO 14001 management
systems.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

1 ISO 14001 -certified
environmental management
system

Certified Quality System

150 9001

Certified Environmental System

IS0 14001

Cher client,

Vous avez choisi d'acheter un
produit Rohde & Schwarz. Vous
disposez donc d'un produit
fabriqué d'aprés les méthodes
les plus avancées. Le dévelop-
pement, la fabrication et les
tests de ce produit ont été effec-
tués selon nos systémes de
management de qualité et de
management environnemental.
La société Rohde & Schwarz a
été homologuée, entre autres,
conformément aux systémes
de management ISO9001 et
ISO 14001.

Engagement écologique

1 Produits a efficience
énergétique

i+ Amélioration continue de la
durabilité environnementale

1 Systeme de management
environnemental certifié selon
ISO 14001
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00
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1.1

Documentation Overview

Preface

Documentation Overview

The user documentation for the R&S AMU consists of the following parts:
® Quick start guide, printed manual
® Online help system on the instrument

® Operating manuals and online manual for base unit and options provided on the
product page

® Service manual provided on the internet for registered users

® |nstrument security procedures provided on the product page
® Release notes provided on the product page

® Data sheet and brochures provided on the product page

® Application notes provided on the Rohde & Schwarz website

You find the user documentation on the R&S AMU product page mainly at:
http://www.rohde-schwarz.com/product/AMU200A.html > "Downloads" > "Manuals"

Additional download paths are stated directly in the following abstracts of the docu-
mentation types.

Quick Start Guide

Introduces the R&S AMU and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc.

Online Help

Offers quick, context-sensitive access to the information needed for operation and pro-
gramming. It contains the description for the base unit and the software options.

Operating Manuals and Online Manual

Separate manuals are provided for the base unit and the software options:

® Base unit manual
Contains the description of the graphical user interface, an introduction to remote
control, the description of all SCPI remote control commands, programming exam-
ples, and information on maintenance, instrument interfaces and error messages.
Includes the contents of the quick start guide manual.

® Software option manuals
Describe the specific functions of this option. Basic information on operating the
R&S AMU is not included.

The online manual provides the contents of the operating manual for immediate dis-
play on the internet.


http://www.rohde-schwarz.com/product/AMU200A.html

1.2

Typographical Conventions

Service Manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS).
Instrument Security Procedures

Deals with security issues when working with the R&S AMU in secure areas.

Data Sheet and Brochures

The data sheet contains the technical specifications of the R&S AMU. Brochures pro-
vide an overview of the instrument and deal with the specific characteristics, see http://
www.rohde-schwarz.com/product/AMU200A.html > "Download" > "Brochures and Data
Sheets".

Release Notes

Describes the firmware installation, new and modified features and fixed issues
according to the current firmware version. You find the latest version at:

http://www.rohde-schwarz.com/product/AMU200A.html > "Downloads" > "Firmware"

Application Notes, Application Cards, White Papers, etc.

These documents deal with special applications or background information on particu-
lar topics, see http://www.rohde-schwarz.com/appnotes.

Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description
"Graphical user interface ele- All names of graphical user interface elements on the screen, such as
ments" dialog boxes, menus, options, buttons, and softkeys are enclosed by

quotation marks.

KEYS Key names are written in capital letters.

File names, commands, File names, commands, coding samples and screen output are distin-

program code guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.



http://www.rohde-schwarz.com/product/AMU200A.html
http://www.rohde-schwarz.com/product/AMU200A.html
http://www.rohde-schwarz.com/product/AMU200A.html
http://www.rohde-schwarz.com/appnotes

Notes on Screenshots

1.3 Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic test situations.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-

ticular product configuration.



Notes on Screenshots
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2 Preparing for Use

The following topics will help you to get familiar with the instrument and perform the
first steps:

® Front Panel Tour
® Rear Panel Tour
® Putting into Operation

This section explains the control elements and connectors of the Signal Generator
R&S AMU with the aid of the front and rear views and describes how to put the instru-
ment into operation. It also describes the connection of peripherals such as printer,
keyboard or mouse. Specifications of interfaces can be found in the data sheet.

The Chapter 3, "Getting Started", on page 63 of this manual provides an overview of
the generator functions and introduces the operating concept. Detailed operating
instructions and an overview of menus follow in Chapter 4, "Manual Operation”,

on page 87.

For all reference information concerning manual and remote control of the instrument
refer to the online help system or its printed/printable version. A more detailed descrip-
tion of the hardware connectors and interfaces is also part of the help system.

2.1 Front Panel Tour

The front panel of the R&S AMU consists of the VGA display with the softkey area,
some utility keys (left side) and the hardkey area with connectors and control interfaces
(right side). The subsequent sections provide brief explanations on the controls and
connectors, the hardkey area and the front panel.

@ For more detailed information, refer to the corresponding description in the Operating
Manual.
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Figure 2-1: Front panel view

Utility Keys
The keys to the left of the display cause the R&S AMU to return to a definite instrument
state and provide information on the instrument and assistance.

For more information refer to chapter "Instrument Settings" in the Operating Manual.

PRESET
Sets the instrument to a defined state (see Chapter 2.3.5.4, "Default Settings”,

on page 30).

LOCAL
Switches from remote control to local (manual) control.

SETUP
Opens the "Setup" dialog for configuring presettings.

HCOPY
Opens the "Hardcopy" menu for configuring and starting printing.

INFO
Displays status messages, error messages and warnings.
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HELP
Displays context-sensitive help text.

2.1.2 Standby LEDs and Standby Key
on sTanner - The standby LEDs and the ON/STANDBY key are located in the bottom left corner of
the front panel.

The ON/STANDBY key toggles the instrument between standby and ready state (indi-
cated by the standby LEDs).

The standby LEDs indicate the instrument states as follow:
® the green LED (left) is on when the instrument is ready for operation,
® the yellow LED (right) is on in the standby mode.

See also Chapter 2.3.5.1, "Standby and Ready state", on page 29.

2.1.3 Display

The display clearly shows all main settings and signal generator states.

The display is divided into the following sections:
® | evel display with info line

— Level and PEP settings containing auxiliary information such as insertion loss,
crest factor and load type.
In two-path instruments, level and PEP are displayed in two lines.

— Status messages

— Brief error messages; to access an window with detailed information for a mes-
sage, use the INFO key.

® Block diagram
The block diagram shows the current configuration and the signal flow in the gen-
erator with the aid of function blocks containing an on/off switch. Selecting a func-
tion block opens a list of associated setting menus. Active menus, info windows
and graphs are displayed on top of the block diagram. The block diagram can be
displayed in the foreground anytime with the DIAGRAM key.

® "Winbar" with labelled softkeys
Open menus are indicated by a labelled button in the "Winbar". The buttons deter-
mine the softkey functions for front-panel control. When a button or softkey is
pressed, the associated menu is displayed either in the foreground or minimized in
the "Winbar".
If required, the WINBAR is covered by a row of buttons to which menu-specific
functions of the active menu are assigned. By pressing the WINBAR key, the "Win-
bar" can be displayed in the foreground again. This allows the user to toggle
between the button and softkey functions.

For detailed information, see Chapter 4.2, "Display”, on page 92.
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21.4 Setup Keys

The keys to the right of the display set parameters, select views and control the win-
dows.

2.1.41 Keys for Setting Parameters

These keys provide direct access to the settings in the header of the instrument and
can be used for fast changing the state of the baseband signal.

For more information refer to chapter "Instrument Functions" in the Operating Manual.

BASEBD LEVEL

Activates the baseband level entry. In the two-path mode, the baseband level entry
field that was active last is activated. Pressing the key again activates the baseband
level entry for the second path.

BASEBD ON/OFF

Switches the Baseband signal on and off. In the two-path mode, the BASEBD ON/OFF
key switches all signals off. A second stroke restores the status that was active before
the last switch-off. "I/Q OUT OFF" is displayed in the status bar.

FILE
Activates the menu for storing or loading files (see Chapter 4.7, "File Management",
on page 115).

RECALCULATE
Starts the recalculation of instrument settings.

If time-consuming calculations are required, the active modulation is automatically
switched off and the calculation is interrupted to allow the user to make further settings.
Calculation is restarted by a keystroke and the modulation is switched on again after
the calculation is completed.

2.1.4.2 Display Keys

The keys on top of the rotary knob and the keys below the numeric key pad arrange
different windows on the display.

DIAGRAM
Brings the block diagram to the foreground. Active menus are minimized.

Active menus are indicated by the buttons in the "Winbar".
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ESC

The function of this key depends on the current cursor position.

® (Calls the next higher selection level.

® Closes the open window without accepting new entries; the old value or parameter

is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or to

the previously highlighted block in the block diagram if no menu is active.

® Shifts the cursor from a function block in the diagram to the first item in the "Win-
bar". If no menus are open, the current cursor position remains unchanged.

TOGGLE

® Switches highlighted elements or a function block on and off.

® Switches between two or more settings, e.g. items of selection lists. At the end of a
list, the cursor is set on the first entry again.

MENU
Calls the menu tree.

CLOSE

Closes the active menu.

® |f the entry mode is active, changes are cancelled.

® |f settings in this menu require acknowledgment by means of an "Accept" button, a
query is displayed asking whether the changes made should be cancelled.

HIDE
Minimizes the active open menu. The associated button in the "Winbar" remains visi-
ble.

REARR
Automatic rearrangement of open menus.

WINBAR
Toggles between display and blanking of the "Winbar".

2.1.5 Keypad for data entry

The keys in the data entry keypad are used to enter alphanumeric data and units.

Data entry keys are only enabled while the cursor is placed on a data input field in a
dialog. Their function depends on the data type of the input field.
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Keys Description
0...9/abc Enters the corresponding numbers (in numeric input fields) or characters (character input
fields).

Inserts a decimal point (numeric input fields) or dot (character input fields) at the cursor
position. Multiple decimal points are not allowed.

+/- Changes the sign of a numeric parameter. In the case of an alphanumeric parameter,
inserts a hyphen at the cursor position.

Unit keys Selects a unit and thus determine the absolute value, or changes the unit, i.e. trigger a
recalculation without changing the absolute value. The function depends on the time at
which the UNIT key is used during parameter entry (see Chapter 4.4.5, "Working with Units
", on page 104).

For unit-free values, the X1 key is equivalent to ENTER. It confirms the previous entry and
deactivates the input field.

Adds a blank in a character input field.

L # Enters special characters. Toggles through the available characters if the key is pressed
several times in a row.

A<->a Toggles between uppercase and lowercase characters.

A,B,C,D, Enters hexadecimal values. The letters assigned to the keys are automatically active when
E,F an entry field with a hexadecimal value is active.

INSERT

Toggles between insert and overwrite mode (see also Chapter 4.4.4, "Entering a
Value", on page 102 ).

BACKSPACE
Deletes the last character before the cursor position or the selected character
sequence.

ENTER
Pressing the rotary knob has the same effect.

® Concludes the entry of dimensionless entries. For other entries, this key can be
used instead of the default unit key. The new value is accepted.

Confirms ("OK") and closes open input windows.

In a dialog box, selects the default or focused button.

In a dialog box, activates the edit mode for the focused area, if available.

In a dialog box, activates or deactivates the selected option of the focused area, if
the edit mode is active.

® (Calls the next menu level.
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Rotary Knob and Navigation Keys

The rotary knob and the arrow keys are alternative control elements for data variation
and navigation in the graphical user interface.

ROTARY KNOB

The rotary knob has several functions:

® |ncreases (clockwise direction) or decreases (counter-clockwise direction) numeric
values at a defined step width in editing mode

Moves the cursor, e.g. to a function block in the block diagram

Scrolls within lists, tables or tree views

Acts like the ENTER key, when it is pressed.

Shifts the selection bar within focused areas (e.g. lists), if the edit mode is activa-
ted.

Note: Turning or pressing the rotary knob is equivalent to pressing the UP and DOWN
keys or the ENTER key in the keypad.

NAVIGATION KEYS
The navigation keys consist of 4 arrow keys which are used for navigation, alternatively
to the rotary knob.

UP/ DOWN The up and down arrow keys do the following:

KEYS ® |n a numeric edit dialog box, increase or decrease the instrument

parameter.
® |n a list, table, window or dialog box, scroll vertically.

LEFT/ RIGHT  The left and right arrow keys do the following:

KEYS ® |n an alphanumeric edit dialog box, move the cursor forward and

back.
® |n a list, table, window or dialog box, scroll horizontally.

Front Panel Connectors

I/Q input and output connectors and various additional interface connectors are located
on the front panel. Connectors that are assigned to one of the two paths are marked
with the appropriate letter A or B. Not particularly marked interfaces affect both paths.

/QIN

I and Q inputs for external analog baseband signal (option R&S AMU-B17, Baseband
Input).

For more information see:

® chapter "Data and Signal Sources in Baseband" in the Operating Manual

® chapter "Baseband Input Settings Menu" in the Operating Manual.
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I/Q OUT A/B
Direct output or differential (non-inverting) output of the analog 1/Q signal (option
R&S AMU-B16, Baseband differential).

For more information see:
e chapter "Data and Signal Sources in Baseband" in the Operating Manual
® chapter "Baseband Input Settings Menu" in the Operating Manual.

CLOCK
Signal for Path A only.

Input for external clock signal (bit or symbol clock, multiple of symbol clock) for syn-
chronizing the external data signal in case of multivalent modulation. The active edge
can be set.

Output for clock signal (bit or symbol clock) in the internal mode.

DATA
Signal for Path A only.

Input for external serial data signal in case of digital modulation.
Output for serial data signal in case of digital modulation.

For more information see:
e chapter "Data and Signal Sources in Baseband" in the Operating Manual
® chapter "Baseband Input Settings Menu" in the Operating Manual.

TRIGGER 1
Input for triggering digital modulations, standards and ARB.

For more information see chapter "Global Trigger Clock Input Settings" in the Operat-
ing Manual.

usB
USB (universal serial bus) interfaces of type A (host USB).

® Connection of peripherals such as mouse or keyboard
® Connection of memory stick for file transmission
® Firmware update

Note:

Further USB interfaces are provided on the rear panel:

e 2 type Ainterfaces (USB 1.1 and USB 2.0)

® 1 type B interface (device USB for data transmission)

See also Chapter 2.4.1, "Connecting USB Devices", on page 32.

MARKER 1A, 2A
Outputs 1 and 2 for triggering and control of external devices with user-definable
marker signals.

The instrument provides four outputs for marker signals. Marker signals 1 to 3 are per-
manently assigned to the outputs; marker signal 4 can be routed to one of the four
USER outputs. The assigment is as follow:



R&S®AMU200A Preparing for Use
________________________________________________________________________________________________________________________________________________________|

Path A
e Marker 1,2: BNC connectors MARKER 1A/2A on the front panel, or on the rear
panel.

Marker 3: MARKER 3A pin of the AUX I/O connector on the rear panel.
Marker 4: BNC connector USER 1 or USER 2/3/4 pins of AUX I/O connector on
rear panel.

Path B

® Marker 1: MARKER 1B/2B output on the rear panel.

® Marker 3: MARKER 3B pin of the AUX I/O connector on rear panel.

® Marker 4: BNC connector USER 1 or USER 2/3/4 pins of AUX I/O connector on
rear panel.

For more information see section "Global Trigger/Clock/Input Settings" in the Operating

Manual.

2.2 Rear Panel Tour

This section gives an overview of connectors on the rear panel of the instrument. Each
connector is briefly described and a reference is given to the chapters containing
detailed information. For technical data of the connectors refer to the data sheet.

If a connector of a two-path instrument is available for one path only (for example path
A) or for either of the two (path A or B), a note is made in the brief description.

@ For more detailed information, refer to the corresponding description in the Operating
Manual.

100...280VAG/40... 15 A
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Figure 2-2: Rear panel view
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2.2.1 Description of the Connectors

LAN CONNECTOR

Ethernet interface

For integrating signal generators in a network
Remote control of signal generator

Input of external asynchronous data

Remote access to the signal generator
Firmware update

See also:
® Chapter 2.6, "Setting Up a Network (LAN) Connection", on page 35
® chapter "Remote Control Basics" in the Operating Manual

AC SUPPLY AND POWER SWITCH

When the R&S AMU is connected to the AC supply, it automatically sets itself to the
correct range for the applied voltage (range: see type label). There is no need to set
the voltage manually or change fuses.

The power switch can be set to two positions:

e 0
The instrument is disconnected from the mains.

o |
The instrument is power-supplied. It is either ready for operation (STANDBY) or in
operating mode, depending on the position of the ON/STANDBY switch on the
instrument front.

See also data sheet and Chapter 2.3.4, "Connecting the Instrument to the AC Supply",
on page 28.

I/IQIN A/B
Input for external analog modulation signal in case of I/Q modulation (independent for
path A and B).

Input for external analog baseband signal (option R&S AMU-B17, Baseband Input).
Rear panel connectors for path A and path B (option R&S AMU-B81).

This option is recommended for use of the instrument in a 19" rack. Installing the
instrument in a 19" rack requires a rack adapter or an adapter for telescopic sliders
(refer to data sheet for order number).

For more information see chapter "Data and Signal Sources in Baseband" and "I/Q
Settings" and in the Operating Manual.

e
Quick Start Guide 1402.5200.62 — 08 20
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1/Q OUT, I/Q BAR OUT
(path A or path B)

Direct output or differential (non-inverting) output for analog 1/Q signal. For differential
output option R&S AMU-B16 is required.

For the use of the instrument in a 19" rack, we recommend that you use the connectors
for path A and B on the back (option R&S AMU-B81). Installing the instrument in a 19"
rack additionally requires a rack adapter or an adapter for telescopic sliders (refer to
data sheet for order number.).

See also "Analog I/Q Output Settings" in the Operating Manual.

INSTR TRIG
The INSTR TRIG connectors are reserved for future extensions.

RESERVE
The RESERVE connector is reserved for future extensions.

USER
Input/output for configurable signals for triggering and control.

The following signals can be applied to the connector:
® Marker 4

® Clock Out (bit or symbol)

® CW mode Out

® No signal (blank) marker

Note: With exception of the Clock Out signal, the signals for triggering and control
apply for both paths.

IEC 625/IEEE 488
IEC-bus (IEEE 488) interface for remote control of the instrument.

See also Chapter A.1, "GPIB Bus Interface", on page 125 and chapter "Remote Con-
trol Basics" in the Operating Manual.

Note: In order to avoid electromagnetic interference (EMI) caused by open lines,
always terminate any connected IEC-bus cable with an instrument or a controller.

MARKER 1A/2A, 1B/2B
Outputs 1 and 2 for triggering and control of external devices with user-definable
marker signals.

The instrument provides four outputs for marker signals. Marker signals 1 to 3 are per-
manently assigned to the outputs; marker signal 4 can be routed to one of the four
USER outputs (see "MARKER 1A, 2A" on page 18). The assigment is as follow:

Path A
® Marker 1,2: BNC connectors MARKER 1A/2A on the rear panel, or on the front
panel.

® Marker 3: MARKER 3A pin of the AUX I/O connector on the rear panel.

Quick Start Guide 1402.5200.62 — 08 21
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® Marker 4: BNC connector USER 1 or USER 2/3/4 pins of AUX I/O connector on
rear panel.

Path B

® Marker 1,2: MARKER 1B/2B output on the rear panel.

® Marker 3: MARKER 3B pin of the AUX I/O connector on rear panel.

® Marker 4: BNC connector USER 1 or USER 2/3/4 pins of AUX I/O connector on
rear panel.

For the use of the instrument in a 19" rack, we recommend that you use the connectors
for path A and B on the back (option R&S AMU-B81). Installing the instrument in a 19"
rack additionally requires a rack adapter or an adapter for telescopic sliders (refer to
data sheet for Order No.).

Note: MARKER 1A and 2A outputs are intended for future upgrades (option
R&S AMU-B81).

For more information see section "Global Trigger/Clock/Input Settings" in the Operating
Manual.

See also Chapter 2.3.3, "Placing or Mounting the Instrument”, on page 26.

ilged REF OUT
Output of internal reference signal.

REFIN-&) REF IN
/ Input for external reference signal.
The external reference is used for both paths.

DATA IN/OUT
Clock signal input/output.

Rear Panel Connectors for path A and path B (option R&S AMU-B81).

This option is recommended for use of the instrument in a 19" rack. Installing the
instrument in a 19" rack requires a rack adapter or an adapter for telescopic sliders
(refer to data sheet for order number).

DATA IN Input for external serial data signal in case of digital modulation (path
A). The active edge can be set (path A only).

DATA OUT Output for serial data in case of digital modulation (path A).

CLOCK OUT
Output for internal clock signal.

This connector is used for path A only. The internal clock signal of path B can be out-
put at one of the USER interfaces.

CLOCK IN/OUT
Clock signal input/output.

Rear Panel Connectors for path A and path B (option R&S AMU-B81).

This option is recommended for use of the instrument in a 19" rack. Installing the
instrument in a 19" rack requires a rack adapter or an adapter for telescopic sliders
(refer to data sheet for order number).
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CLOCK IN Input for external clock signal (bit or symbol clock, multiple of symbol
clock) for synchronizing the external data signal in case of multivalent
modulation. The active edge can be set (path A only).

CLOCK OUT  Output for internal (bit or symbol) clock signal (path A). The internal
clock signal of path B can be output at one of the USER interfaces.

MONITOR MONITOR
Connector for external monitor (see Chapter 2.4.2, "Connecting a Monitor",
on page 33).

For description of this connector, refer to Chapter A.3, "Monitor Connector (MONI-
TOR)", on page 128.

TRIGGER 1/ 2
TRIGGER 2: Input for external triggering of digital modulations and standards and
ARB.

The trigger input is switchable to path A and/or to path B.

See also "Global Trigger Clock Input Settings".

AUX /O
Erl

Parallel input/output for data signals as well as settable trigger and control signals of
the baseband. Input for device trigger.

Assignment of the AUX I/O interface and of USER pins can be configured in the "Setup
> Global Trigger/Clock/External Inputs" and "Setup > USER Marker / AUX I/O Set-
tings".

Use this dialogs to configure also the arbitrary assignment of pins to path A or B.

Note: An adapter of the AUX I/O interface to coaxial BNC connectors is available as
an accessory (R&S AMU-Z5, see data sheet).

For detailed description of the AUX I/O connector, refer to Chapter A.2, "AUX I/O Con-
nector", on page 126.

BERT
Input for data, clock and control signals for bit and block error rate measurements,
level 0.0128..1.998V.

USB IN
USB (universal serial bus) interface of type B (device USB).

This interface is reserved for futurre extensions.

Note:

Further USB interfaces are provided:

e 2 type A interfaces (master USB ) on the front panel

® 2 type Ainterfaces (USB 1.1 and USB 2.0) on the rear
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USB CONNECTORS TYPE A
USB (universal serial bus) interfaces of type A (host USB1.1 and USB 2.0).

® Connection of peripherals such as mouse, keyboard, etc.
® Connection of memory stick for file transmission
® Firmware update

Further USB interface type A are available on the front panel.

See also Chapter 2.4.1, "Connecting USB Devices", on page 32.

BASEBAND DIGITAL IN/OUT

Digital Interface:

® |nput for external digital I/Q signal (BBIN) in case of digital modulation (option
R&S AMU-B17, Baseband Input (digital/analog)).

e OQutput of the digital I/Q signal (BBOUT) (option R&S AMU-B18 Digital 1/Q Out).

Note: A further digital I/Q signal input requires a second option R&S AMU-B17, Base-
band Input (digital/analog). Respectively, two-path instruments require a second option
for digital I/Q output (option R&S AMU-B18, Digital 1/Q Out).

Electromagnetic interference may disturb the digital data stream. Take precaution by
complying with the EMC safety precautions recommended by Rohde&Schwarz (see
"Risk of electrostatic discharge (ESD)" on page 25).

2.3 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S AMU for
the first time.

A WARNING

Risk of injury and instrument damage

The instrument must be used in an appropriate manner to prevent electric shock, fire,
personal injury, or damage.

® Do not open the instrument casing.
® Read and observe the "Basic Safety Instructions" delivered as a printed brochure
with the instrument.

In addition, read and observe the safety instructions in the following sections.
Notice that the data sheet may specify additional operating conditions.
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Risk of instrument damage

Note that the general safety instructions also contain information on operating condi-
tions that will prevent damage to the instrument. The instrument's data sheet may con-
tain additional operating conditions.

Risk of instrument damage during operation

An unsuitable operating site or test setup can cause damage to the instrument and to
connected devices. Ensure the following operating conditions before you switch on the
instrument:

® All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

® The instrument is dry and shows no sign of condensation.

® The instrument is positioned as described in the following sections.

® The ambient temperature does not exceed the range specified in the data sheet.
® Signal levels at the input connectors are all within the specified ranges.

® Signal outputs are correctly connected and are not overloaded.

Risk of electrostatic discharge (ESD)

Electrostatic discharge (ESD) can cause damage to the electronic components of the
instrument and the device under test (DUT). ESD is most likely to occur when you con-
nect or disconnect a DUT or test fixture to the instrument's test ports. To prevent ESD,
use a wrist strap and cord and connect yourself to the ground, or use a conductive
floor mat and heel strap combination.

For details refer to the basic safety instructions included at the front of the manual.

2.3.1 EMI Suppression

Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated Electromagnetic Interference (EMI),

® Use suitable shielded cables of high quality. For example use double-shielded RF
and LAN cables.
Note: USB cables are of varying and often poor quality. Therefore, check the qual-
ity of each individual USB cable as described in the service manual.

® Always terminate open cable ends.

® Use the cable R&S SMU-Z6 for connection to the DIG I/Q interfaces of the instru-
ment. The required cable is available under part number 1415.0201.02.
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® Note the EMC classification in the data sheet
2.3.2 Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for complete-
ness, proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet and then
carefully remove the pads from the instrument handles at the front.

2. Pull off the corrugated cardboard cover that protects the rear of the instrument.

3. Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

4. Check the equipment for completeness using the delivery note and the accessory
lists for the various items.

5. Check the instrument for any damage. If there is damage, immediately contact the
carrier who delivered the instrument. Make sure not to discard the box and packing
material.

Packing material

Retain the original packing material. If the instrument needs to be transported or ship-
ped at a later date, you can use the material to protect the control elements and con-
nectors.

2.3.3 Placing or Mounting the Instrument

The R&S AMU is designed for use under laboratory conditions, either on a bench top
or in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S AMU is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet, or with the support feet on the
bottom extended.
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A CAUTION

Risk of injury if feet are folded out

The feet may fold in if they are not folded out completely or if the instrument is shifted.
This may cause damage or injury.

Fold the feet completely in or completely out to ensure stability of the instrument.
Never shift the instrument when the feet are folded out.

When the feet are folded out, do not work under the instrument or place anything
underneath.

The feet can break if they are overloaded. The overall load on the folded-out feet
must not exceed 500 N.

A CAUTION

Risk of injury and instrument damage if stacking instruments

A stack of instruments may tilt over and cause injury. Furthermore, the instruments at
the bottom of the stack may be damaged due to the load imposed by the instruments
on top.

Observe the following instructions when stacking instruments:

R

Never stack more than three instruments with the same dimensions (width and
length). If you need to stack more than three instruments, install them in a rack.

The overall load imposed on the lowest instrument must not exceed 500 N.

All instruments should have the same dimensions (width and length).
If you need to stack smaller instruments on the top, the overall load imposed on the
lowest instrument must not exceed 250 N.

If the instruments have foldable feet, fold them in completely.

E l imax. 500 N

4 1\ maxt$50 Ng [ﬂ ::

r 1 \( ,
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Rackmounting

The R&S AMU can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter kit.

Risk of instrument damage in a rack

An insufficient airflow can cause the instrument to overheat, which may disturb the
operation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perforations are
unimpeded, and that the minimum distance from the wall is 10 cm.

2.3.4

2.3.5

Connecting the Instrument to the AC Supply

The R&S AMU is automatically adapted to the AC voltage supplied. There is no need
to set the voltage manually or change fuses. The AC SUPPLY AND POWER SWITCH
is at the rear of the unit.

» Connect the instrument to the AC power source using the AC power cable deliv-
ered with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

Starting the Instrument

Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from
all power supplies.

Starting up instruments with power switch
1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position | (On).

After power-up, the instrument is in standby or ready state, depending on the state
of the ON/STANDBY key at the front panel of the instrument when the instrument
was switched off for the last time.

3. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.
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2.3.5.1 Standby and Ready state
on sTanneY - The ON/STANDBY key is located in the bottom left corner of the front panel.

Switching between standby and ready state

» Press the ON/STANDBY key briefly to switch the instrument from the standby to
ready state or vice versa.

In ready state, the left, green LED is on. The instrument is ready for operation. All
modules are power-supplied and the R&S AMU initiates its startup procedure.

In standby state, the right, yellow LED is on. The standby power only supplies the
power switch circuits and the oven-controlled crystal oscillator to keep it at its oper-
ating temperature. In this state it is safe to switch off the AC power and disconnect
the instrument from the power supply.

2.3.5.2 Start Display and Booting

After power-on, the start display indicates for a few seconds the installed BIOS version
and the processor characteristics.

The instrument boots the operating system, starts the instrument firmware and auto-
matically performs a selftest. If the previous session was terminated regularly, the
instrument uses the last setup with the relevant instrument settings.

Once the startup procedure has been terminated, the block diagram opened in the pre-
vious session is displayed and the instrument is ready for operation.

Use the PRESET key to return the instrument to its definite reset/preset state, if the
current setup is not anymore relevant.

To customize the start settings, use the "File" dialog.

Rebooting the instrument
Press the STANDBY key for approx. 5 s. to reboot the instrument, if the software stops
unexpectedly.

2.3.5.3 Function Check
The signal generator automatically monitors the main functions when the instrument is
switched on and continuously during operation.

A detected fault is indicated by a "ERROR" message displayed in the info line together
with a brief error description. For in-depth identification of the error, press the INFO
key. In response, a description of the error(s) is displayed.

For more information, refer to section "Error Messages" in the Operating Manual.
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Additionaly to the automatic monitoring, the R&S AMU offers the following capabilities
to ensure correct functioning:

® Internal Adjustments
Press the SETUP key and select "System > Internal Adjustments" to access the
dialog for preforming and configuring of the adjustments settings. A maximum level
accuracy can be obtained, for instance.

® Selftest
A selftest is provided for service purposes. The selftest is a protected test proce-
dure, which can be accessed if protection level 1 is disabled.

Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched off. It is also reco-
mended that you use the PRESET key to return the instrument to its defined preset
state every time a new configuration is required or the current setup is not anymore rel-
evant.

The R&S AMU offers a three-stage preset concept:

® Preset of the settings belonging to a digital standard or associated with one dialog.
Most of the dialog boxes provide a special "Set to Default" button that resets
directly the settings associated to the corresponding dialog, e.g. all digital modula-
tion settings in the "Custom Digital Mod" dialog.
These settings are identical to those which are called up using the PRESET key.

® Preset the instrument to a predefined state

The PRESET key calls up a defined instrument setup. All parameters and switch-
ing states are preset (also those of inactive operating modes). The default instru-
ment settings provide a reproducible initial basis for all other settings. However,
functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. GPIB bus address or reference oscillator source settings.
In remote control it is possible to preset the settings of the two instrument's paths
separately (see section "Preset Commands").

® Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, press the SETUP key and select the "Factory Preset".
For more information and an overview of the settings affected by the factory preset
function, see section "Factory Preset" in the Operating Manual.

Overview of the Most Important Preset States

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

e "Reference frequency" = Internal; adjustment off
e "Offsets" =0
® "Modulations State" = Off

Settings that are not affected by the PRESET key

[
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® Reference frequency settings ("Ref Oscillator" menu)

® Power on settings ("Level/EMF" menu)

® Network settings ("Setup” menu)

® GPIB address ("Setup" menu)

® Password and settings protected by passwords ("Setup" menu)
e Start/Stop Display Update ("Setup" menu)

® Display and keyboard settings ("Setup” menu)

@ User-defined instrument states can be stored and called up in the "File" dialog.

2.3.6 Shutting Down the Instrument

To shut down the R&S AMU, proceed as described below.

Risk of losing data

If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data
may be lost.

Press the ON/STANDBY key first to shut down the application properly.

1. Press the ON/STANDBY key to save the current setup, shut down the operating
system and set the instrument to standby state.

The yellow LED must be on.
2. To switch off the power, press the main power switch to position 0 (Off).

None of the front-panel LEDs should be on.

2.4 Connecting External Accessories

The equivalent USB ports on the front and/or rear panel of the R&S AMU can be used
to connect a variety of accessories.

In addition the instrument provides interfaces for monitor connection and network inte-
gration (see Chapter 2.4.2, "Connecting a Monitor", on page 33 and Chapter 2.6.1,
"Connecting the Instrument to the Network", on page 36).
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Connecting USB Devices

The USB interfaces of the R&S AMU allow you to connect USB devices directly to the
instrument. This number can be increased as necessary by using USB hubs. Due to
the large number of available USB devices, there is almost no limit to the expansions
that are possible with the R&S AMU.

The following list shows various USB devices that can be useful:

® Memory stick for easy transfer of data to/from a computer (e.g. firmware updates)
® (CD-ROM drives for easy installation of firmware applications

® Keyboard or mouse to simplify the entry of data, comments, file names, etc.

® Printer for printing out measurement results

® Power sensors, e.g. of the NRP Zxy family

Installing USB devices is easy under Windows, because all USB devices are

plug&play. After a device is connected to the USB interface, the operating system
automatically searches for a suitable device driver.

If Windows does not find a suitable driver, it will prompt you to specify a directory that
contains the driver software. If the driver software is on a CD, connect a USB CD-ROM
drive to the instrument before proceeding.

When a USB device is subsequently disconnected from the R&S AMU, Windows
immediately detects the change in hardware configuration and deactivates the corre-
sponding driver.

All USB devices can be connected to or disconnected from the instrument during oper-
ation.
Connecting a memory stick or CD-ROM drive

If installation of a memory stick or CD-ROM drive is successful, Windows informs you
that the device is ready to use. The device is made available as a new drive and is dis-
played in Windows Explorer. The name of the drive depends on the manufacturer.

Connecting a keyboard

The keyboard is detected automatically when it is connected. The default input lan-
guage is English — US.

Select "Start > Control Panel > Clock, Language, and Region > Change keyboards or
other input methods" to configure the keyboard properties. To access the Windows
operating system, press the Windows key on the external keyboard.

Connecting a mouse

The mouse is detected automatically when it is connected.

Select "Start > Control Panel > Devices and Printers > Mouse" to configure the mouse
properties. To access the Windows operating system, press the Windows key on the
external keyboard.
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Connecting a printer

When printing a file, the instrument checks whether a printer is connected and turned
on and whether the appropriate printer driver is installed. If required, printer driver
installation is initiated. A printer driver needs to be installed only once.

To install a printer, select "Start > Control Panel > Devices and Printers > Add a
printer". To access the Windows operating system, press the Windows key on the
external keyboard.

You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. If the instrument is inte-
grated in a network, you can also install driver data stored in a network directory.

Select "Start > Control Panel > Devices and Printers > Device Manager > Update
Device drivers" to install the driver.

2.4.2 Connecting a Monitor
An external monitor with an analog interface can be connected to the MONITOR con-

nector on the rear panel of the instrument. Per default, the external monitor connector
is disabled and has to be enabled before operation.

Connecting external devices

Before connecting any external device such as a monitor, make sure that the instru-
ment is switched off (or in standby mode). Otherwise, correct operation cannot be
assured. This does not apply to USB devices.

1. Shut down the instrument.

None of the front-panel LEDs should be on.

2. Plug in the monitor cable to the MONITOR connector on the rear panel of the
instrument.

3. Start up the instrument.

The green LED must be on.

The external monitor is detected.

The entire display of the instrument, containing the status bar, the block diagram
and the winbar is displayed on the monitor additionally. Further settings are not
required.

The MONITOR interface is described in "Appendix A: Hardware Interfaces" in the
Operating Manual.
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2.5 Windows Operating System

The instrument contains the Windows Embedded Standard operating system which
has been configured according to the instrument's features and needs. Changes in the
system setup are only required when peripherals like keyboard or a printer are installed
or if the network configuration does not comply with the default settings. After the

R&S AMU is started, the operating system boots and the instrument firmware is started
automatically.

To ensure that the instrument software functions properly, certain rules must be
adhered to concerning the operating system.

Risk of causing instrument unusability

The instrument is equipped with the Windows Embedded Standard operating system.
Additional software can therefore be installed on the instrument. The use and installa-
tion of additional software may impair instrument function. Thus, run only programs
that Rohde & Schwarz has tested for compatibility with the instrument software.

The drivers and programs used on the instrument under Windows Embedded Standard
have been adapted to the instrument. Existing instrument software must always be
modified using only update software released by Rohde & Schwarz.

The following program packages have been tested:

® R&S Power Viewer Plus - virtual power meter for displaying results of the Power
Sensor R&S NRP-Zxx (install only this component!)

® Symantec Endpoint Security — Virus-protection software
® FileShredder - for reliable deletion of files on the hard disk

In certain cases, the use of these programs can impair the performance of the instru-
ment.

2.5.1 Virus Protection

Users must take appropriate steps to protect their instruments from infection. Beside
the use of strong firewall settings and regularly scanning any removable storage device
used with a Rohde & Schwarz instrument, it is also recommended that anti-virus soft-
ware be installed on the instrument. While Rohde & Schwarz does NOT recommend
running anti-virus software in the background ("on- access" mode) on Windows-based
instruments, due to potentially degrading instrument performance, it does recommend
running it during non-critical hours.

For details and recommendations, see the Rohde & Schwarz White Paper 1DCO1:
Malware Protection.
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2.5.2

2.5.3

2.54

2.6

Service Packs and Updates

Microsoft regularly creates security updates and other patches to protect Windows-
based operating systems. These are released through the Microsoft Update website
and associated update server. Instruments using Windows, especially those that con-
nect to a network, should be updated regularly.

For details and recommendations, see the Rohde & Schwarz White Paper 1DCO1:
Malware Protection.

Login

Windows Embedded Standard requires that users identify themselves by entering a
user name and password in a login window. The instrument provides a factory-installed
auto login function, i.e. login is carried out automatically in the background. The ID
used for autologin has administrator rights so that printer and network installations are
possible. The user name and password are set to "instrument".

Accessing the Start Menu

All necessary system settings can be defined in the "Start > Control Panel" menu (for
required settings refer to the Windows Embedded Standard documentation and to the
hardware description).

Energy saving mode

An energy saving mode is a default setting in the instrument. The hard disk switches to
power-save mode if it is not accessed for 30 minutes. The energy-saving mode is exi-
ted by accessing the hard disk again.

Setting Up a Network (LAN) Connection

The R&S AMU is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). Provided the appropriate rights have been assigned by
the network administrator and the Windows firewall configuration is adapted accord-
ingly, the interface can be used, for example:

® To transfer data between a controlling device and the test device, e.g. in order to
run a remote control program.
See chapter "Remote Control" in the R&S AMU User Manual.

® To access or control the measurement from a remote computer using the "Remote
Desktop" application (or a similar tool)

® To connect external network devices (e.g. printers)
® To transfer data from a remote computer and back, e.g. using network folders

This section describes how to configure the LAN interface. It includes the following top-
ics:
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® Chapter 2.6.1, "Connecting the Instrument to the Network", on page 36
® Chapter 2.6.2, "Assigning the IP Address", on page 37

©

LXI

The R&S AMU complies with LXI Class C. LXI gives you direct access to the LAN set-
tings described below.

O

Accessing Operating System

The operating system can only be accessed if an external keyboard and/or a mouse is
connected. Windows provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommended
for extensive entries.

2.6.1

Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

® A non-dedicated network (Ethernet) connection from the instrument to an existing
network made with an ordinary RJ-45 network cable. The instrument is assigned
an |IP address and can coexist with a computer and with other hosts on the same
network.

® A dedicated network connection (Point-to-point connection) between the instru-
ment and a single computer made with a (crossover) RJ-45 network cable. The
computer must be equipped with a network adapter and is directly connected to the
instrument. The use of hubs, switches, or gateways is not required, however, data
transfer is still performed using the TCP/IP protocol. An IP address has to be
assigned to the instrument and the computer, see Chapter 2.6.2, "Assigning the IP
Address", on page 37.
The R&S AMU uses the IP addresses 192.168.xxx.yyy for this purposes, where
xxx and yyy may take values between 1...254; the subnet mask is always
255.255.255.0.

Risk of network failure

Before connecting the instrument to the network or configuring the network, consult
your network administrator. Errors may affect the entire network.

» To establish a non-dedicated network connection, connect a commercial RJ-45
cable to one of the LAN ports.
To establish a dedicated connection, connect a (crossover) RJ-45 cable between
the instrument and a single PC.

If the instrument is connected to the LAN, Windows automatically detects the network
connection and activates the required drivers.



2.6.2

Setting Up a Network (LAN) Connection

The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps
Ethernet IEEE 802.3u interface.

Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.

® If the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

® |f the network does not support DHCP, or if the instrument is set to use alternate
TCP/IP configuration, the addresses must be set manually.

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish a
physical connection to the LAN without any previous instrument configuration.

Risk of network errors

Connection errors can affect the entire network. If your network does not support
DHCP, or if you choose to disable dynamic TCP/IP configuration, you must assign
valid address information before connecting the instrument to the LAN. Contact your
network administrator to obtain a valid IP address.

Assigning the IP address manually

1. Obtain the IP address and subnet mask for the R&S AMU and the IP address for
the local default gateway from your network administrator. If necessary, also obtain
the name of your DNS domain and the IP addresses of the DNS and WINS servers
on your network. If you use more than one LAN connector, you need separate
address information for each connector.

Press the "Windows" key to access the operating system.
Open the "Control Panel" by selecting "Start > Settings > Control Panel".

Select "Network Connections".

o > o DN

Right-click "Local Area Connection" and select "Properties" from the context-sensi-
tive menu, or
click "Local Area Connection" and then "File > Properties".

6. On the "General" tab, click "Internet Protocol (TCP/IP)" and then select "Proper-
ties".

7. Select "Use the following IP address" and enter the address information as
obtained from the network administrator.
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8. If necessary, you can also select "Use the following DNS server addresses" and
enter your own DNS addresses.

For more information refer to the Windows Help.

Using computer names

In a LAN that uses a DNS server (Domain Name System server), each PC or instru-
ment connected in the LAN can be accessed via an unambiguous computer name
instead of the IP address. The DNS server translates the host name to the IP address.
This is especially useful when a DHCP server is used, as a new IP address may be
assigned each time the instrument is restarted.

Each instrument is delivered with an assigned computer name, but this name can be
changed.

The default instrument name is a non-case-sensitive string that follows the syntax
rs<instrument><serial number>.

The serial number can be found on the rear panel of the instrument. It is the third part
of the device ID printed on the bar code sticker:

&> 1D: 1419.0035K02 -[101441]- Zd | seriat number

Querying and changing a computer name

1. Press the "Windows" key to access the operating system.

2. Select "Start > My Computer > Properties > Computer Name".

The computer name is displayed under "Full Computer Name".

3. To change the computer name, select "Change", enter the new computer name
and confirm the entry.

Changing the Windows Firewall Settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends the use of the firewall on
your instrument. Rohde & Schwarz instruments are shipped with the Windows firewall
enabled and preconfigured in such a way that all ports and connections for remote
control are enabled.

For more details on firewall configuration, see the Rohde & Schwarz White Paper
1DCO01: Malware Protection.

Note that changing firewall settings requires administrator rights.

[
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To transfer waveform files generated on an external PC using R&S WinlQSIM2, you
have to disable the firewall.

Risk of Unauthorized Access

Disabling the firewall or allowing exceptions may make your instrument more vulnera-
ble to viruses and intruders.

It is recommended that you restore the default firewall configuration after completing a
task which requires modified settings.

2.6.5 Working with Directories

Access to network drives depends on access rights and whether the drives in question
have been enabled. The complete integration of the R&S AMU into a larger network
with the necessary allocation of rights is highly complex and normally performed by a
network administrator.

However, the hard disk of a computer also connected to the network can be accessed
from the instrument relatively easily. The only precondition is that the directory on the
remote computer that the instrument should access is enabled for remote access. Sub-
sequently, this directory is accessed from the instrument using a Windows Embedded
Standard search function. This procedure is also of importance for a point-to-point con-
nection, for instance in order to start a firmware update for which the files have been
stored on the hard disk of the remote computer.

The computer and the instrument must both be provided with a computer name and an
IP address (see Chapter 2.6.2, "Assigning the IP Address", on page 37).

Enabling directories on the remote computer

The menu name may deviate from the name specified in the operating sequence,
depending on the language and on the operating system used on the computer.

1. On the remote computer, in Windows Explorer, click the directory to be enabled.
2. From the context menu, select "Properties".

3. Select the "Sharing" tab and enable "Share this folder".

Accessing the enabled directory

1. On the instrument, select "Start > Search > For Files and Folders > Printers, Com-
puters > A Computer in the Network".

2. Enter the computer name and press ENTER to start the search.
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The computer and its name appears in the results list.

3. Click the computer's name to display the enabled directory.

Note: If a user name and password are requested when you click the computer,
the login name and password used on the computer must be entered.

The files in this directory can be accessed by the instrument.

2.7 Remote Access via an External Controller

The R&S AMU can be remote accessed from a remote computer (external controller)
via a network link. This allows convenient operation of the instrument from the desktop
although the instrument is integrated in a rack somewhere else.

For an overview of the instrument's operating concept and the different ways to control
and operate the instrument, see Chapter 3.1, "Brief Introduction to the Instrument's
Concept", on page 63.

There are different ways to establish a remote access connection to the signal genera-
tor but all of them require an established LAN connection between the instrument and
the remote computer. The simplest way to remote access the instrument is to use a
Web browser, such as Windows Internet Explorer or Mozilla Firefox for instance. Alter-
natively a remote access via a special application can be used.

For example, the free-of-charge programs "Remote Desktop" for PCs with windows
operating system, or "Ultr@VNC" for PCs with Linux/Unix or Windows operating sys-
tem are available for setting up the remote access connection. Using these applica-
tions requires additional installation.

See the following table for an overview of the different ways to establish a remote
access connection to the signal generator.

Table 2-1: Remote access via an external computer

Remote access via Installation of the additional
LAN application
connec-
tion on the on the remote
instrument computer
Web Browser required no no

for example Windows Internet Explorer or Mozilla Firefox

see Chapter 2.7.1, "Using a Web Browser for Remote
Access", on page 41

Web browser with HTML5 required no Web sockets must

for example LXI Browser, see Chapter 2.9.2.4, "Web be supported.
Control", on page 59
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Remote access via Installation of the additional
LAN application
connec-
tion on the on the remote
instrument computer
Remote Desktop required no required
Windows application for PCs with Window operating sys-
tem
see Chapter 2.7.2, "Remote Desktop Connection",
on page 42
VNC Client required required VNC Viewer

for example Ultr@VNC or other dedicated client software required

for PCs with Linux/Unix or Windows operating system

see Chapter 2.7.3, "Remote Access via a VNC Client
Software", on page 45

When the connection is set up with Remote Desktop, the device firmware of the signal
generator is disabled. Direct control on the instrument is not possible while manual
remote-control is active. The access of an external PC is indicated by the logon screen
of the operating system which identifies the accessing user.

When the connection is set up with a VNC client software (Ultr@VNC), direct control
on the instrument is possible while remote access is established.

For return to direct operation on the instrument, the connection must be cut. After cut-
ting the connection, it is still enabled and can be established again any time. The con-
nection is disabled only after deactivation of the program.

This section gives an information on how to use the Web browser for remote access,
how to install the applications for remote access and how to establish the connection
between the instrument and an external computer with Windows operating system.
Remote access via an external computer with Linux/Unix operating system is per-
formed accordingly.

Accessing Operating System

The operating system can only be accessed if an external keyboard and/or a mouse is
connected. Windows provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommended
for extensive entries.

Default password
Remote-access and file access require the user "instrument" with default password
"instrument"”.

2.71 Using a Web Browser for Remote Access

The instrument can be remote-accessed via any web browser, as for example the Win-
dows Internet Explorer or Mozilla Firefox.
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Alternatively, you can also make use of the LXI browser, as described in Chap-
ter 2.9.2.4, "Web Control", on page 59.

To remote access the instrument via a web browser:

1. Connect the instrument and the remote computer to a LAN, see Chapter 2.6.1,
"Connecting the Instrument to the Network", on page 36.

2. Instal the Java Runtime Environment JRE on the remote computer.

3. Type the instruments' IP address in the address field of the Web browser on your
PC, e.g. http://10.111.11.1

The "VNC Authentication" screen appears.

/= TightVYNC applet - Windows Internet Explorer

—

ﬁ:“tﬂ v | &) hitp:f10.111.11.1) =

File Edt ‘“iew Favortes Tools Help

w o ‘Qfmm:m [ ‘

Disc 'Z::inl'f!_'ll Options | Clipboard | Send Ctrl-Alt-Drel | Refresh |

VNC Authentication

Password: | OK |

4. Enter the password and select "OK".
The default password is "instrument".

After the connection is established, the current signal generator screen with the
block diagram is displayed and the instrument can be remote-accessed from the
remote computer.

2.7.2 Remote Desktop Connection

Remote Desktop is a Windows application which can be used to access and control
the instrument from a remote computer through a LAN connection. While the instru-
ment is in operation, the instrument screen contents are displayed on the remote com-
puter, and Remote Desktop provides access to all of the applications, files, and net-
work resources of the instrument. Thus, remote operation of the instrument is possible.
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Risk of Unauthorized Access

If the Windows Remote Desktop application is enabled on the instrument (go to "Start
> Settings > Control Panel > System"), any user in the network who knows the com-
puter name and login data can access it. To prevent this, make sure that the Remote
Desktop application on the instrument is disabled.

To set up a Remote Desktop connection
1. Enable remote desktop control on the instrument.

2. Connect the instrument and the remote computer to a LAN, see Chapter 2.6.1,
"Connecting the Instrument to the Network", on page 36.

3. Set up the Remote Desktop connection between the remote computer and the
instrument.

Remote Desktop Client

6 With Windows Embedded Standard, Remote Desktop Client is part of the operating
system and can be accessed via "Start > Programs > Accessories > [Communications
>] Remote Desktop Connection.".
For other versions of Windows, Microsoft offers the Remote Desktop Client as an add-
on.

Enabling remote desktop control on the instrument

1. Press the "Windows" key to access the operating system.

2. Open the Control Panel by selecting "Start > Settings > Control Panel".
3. Select "System" and switch to the "Remote" tab.
4

Under "Remote Desktop", activate the "Allow users to connect remotely to this
computer" option.

Note: Remote Desktop access and firewall settings.
When you enable or disable the Windows Remote Desktop option (in the "System
Properties"), the associated firewall settings are adapted automatically.

5. If necessary, click "Select Remote Users" and select users who are to be given
access to the R&S AMU via Remote Desktop. The user account under which con-
figuration is carried out is automatically enabled for Remote Desktop.

Setting up the Remote Desktop connection on the remote computer

1. On the remote computer, select "Start > Programs > Accessories > [Communica-
tions >] Remote Desktop Connection."

2. Enter the instrument's name or IP address in the dialog box (see also Chap-
ter 2.6.2, "Assigning the IP Address", on page 37).
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3. Enter the user ID and password for the instrument (see also Chapter 2.5, "Win-
dows Operating System", on page 34).

4. Click "Connect".

When the connection has been set up, the instrument's screen appears on the
remote computer.

Disabled Direct Control
While remote access is active, the direct control of the instrument is disabled.

Remote access is indicated on the instrument by the logon screen of the operating sys-
tem. The logon screen identifies the accessing user.

For simultaneous remote access of several instruments from the same PC, a separate
Remote Desktop session must be opened for each instrument.

For detailed information about Remote Desktop and the connection refer to the Win-
dows Help.

Helpful settings for Remote Desktop

The following settings for the Remote Desktop connection can make working on the
remote PC more convenient.

1. When setting up the connection to the instrument, you can configure the connec-
tion settings in the "Remote Desktop Connection" dialog box.
Click the "Options >>" button.

The dialog box is expanded to display the configuration data.

2. Customize the settings:

e On the "Experience" tab:

— Select the appropriate connection to optimize the connection speed.

— To improve the performance, you can deactivate options you do not require
under "Allow the following".

e On the "Local Resources" tab:

— If you need to access drives of the remote PC from the instrument (e.g. in
order to store settings or to copy files from the PC to the instrument), acti-
vate the "Disk drives" option. Windows Embedded Standard will then map
drives of the remote PC to the corresponding network drives. When a con-
nection is established, a warning is displayed on the PC indicating that the
drives are enabled for access from the instrument.

— To use printers connected to the remote PC while accessing them from the
instrument, activate the "Printers" options. Do not change the remaining
settings.

e On the "Display" tab:

— Under "Remote desktop size", set the size of the R&S AMU window on the
desktop of the remote PC.

— Activate the "Display the connection bar when in full screen mode" option.
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A bar showing the network address of the instrument is displayed on the
screen which you can use to reduce, minimize or close the window.
e On the "General" tab:
You can save the connection settings for later use using the "Save As" button.

Terminating Remote Desktop Control

A Remote Desktop connection can be terminated either on the R&S AMU or on the
remote PC. The connection can be established again any time as long as remote con-
trol is enabled on the instrument. Consider the notice above concerning unauthorized
access due to Remote Desktop!

1. To terminate the connection on the instrument, click "Disconnect" in the remote-
control message menu of the R&S AMU.

2. To terminate the connection on the remote PC, close the "Remote Desktop" win-
dow, or select "Start > Disconnect".

Disabling Remote Desktop Control
To disable the remote access, deactivate the Remote Desktop on the instrument.

» Under "Remote Desktop", disable the "Allow users to connect remotely to this com-
puter" option and confirm with "OK".

The connection is disabled, it is no longer possible to access the instrument via
Remote Desktop.

2.7.3 Remote Access via a VNC Client Software

A VNC client software is an application which can be used to access and control the
instrument from a remote computer via LAN.

The following description explains how to establish the remote access, represented by
means of the client software Ultr@VNC. The software is included in Linux/Unix operat-
ing system, but it is also available as a free-of-charge download on the Internet http://
www.uvnc.com/download/index.html. Thus, it is also available for remote computers
with Windows operating system.

The GUI appearance of Ultr@VNC may vary if you use a later release. Also, similar
programs may deviate in some details, but the basic procedure is the same.

Risk of Unauthorized Access

If the VNC service is enabled on the instrument, any user in the network who knows
the computer name and password can access it.

Disable the VNC service on the instrument to prevent unauthorized access.
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Setting up a VNC connection

1. Connect the instrument and the remote computer to a LAN, see Chapter 2.6.1,
"Connecting the Instrument to the Network", on page 36.

2. Install the Ultr@VNC application and enable it on the instrument.

3. Inthe ICF firewall, enable communication on the network via Ultr@VNC program.
See "Configuring Internet Connection Firewall for VNC Connection" on page 48.

4. Install the VNC Viewer on the remote computer with Windows operating system,
see "Installing the VNC Viewer on a Windows PC" on page 49.

5. Set up the VNC connection between the instrument and:

a) the remote computer with Linux/Unix operating system, see "Setting up the
VNC connection on the Linux/Unix remote computer" on page 49;

b) the remote computer with Windows operating system, see "Setting up the VNC
connection on the Windows remote computer" on page 50.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be control-
led from the front panel and via the remote computer alternately.

Installing the Ultr@VNC application

1. Download the program from the internet and copy it to a directory that can be
accessed.

2. On the instrument, shut down firmware using the ALT+F4 key combination.

3. Double click on the setup file to start the installation.
The setup wizard leads through the installation. This description focus only on the
relevant settings.

a) Select installation of all components.

100RC 1S

Select Components
Which components should be installed?

Select the components you want to install: clear the components you do not want to
inztall. Click Mext when you are ready to confinue.

| Full ingtallation
UM Server

Current selection requires at least 2.7 MB of disk space.

| < Back || MNext > Cancel
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b) In the "Additional Task Panel", enable all entries.

Select Additional Tasks
‘which additional tasks should be pesformed?

Select the addbional tasks you would ke Setup to perform while instaling Lin@&YHE
Release 1.0.0 RC 18, then chick Next.

Server configuration:

Register LIEWNE Server as a system senvice
Start or restart Uk@VNC service

Additional icons:

Create a Ulr@WMEC Viewer deskiop icon
Create 8 Ur@VNC Server desktop icon
Create a Ulr@MC Bepeater deskiop icon
Fila Associations:

[¥] Associate vne fles with UEWYNC Viewer

[ <Bock ][ Mew> | | Concel |

A successful installation is indicated by a message.
x|

1 The WinvNC service was successfully registered
1 The service may be starked from the Control Panel, and will
be run the next time this machine ks resst

At the same time a warning is displayed stating that a password must be set.

WinVHC Error &

1 'WARNING : This machine has no defaul password set. Win'WhC wall present the Default
. Properties dislog now to allow one to be entered.

4. Select "OK".

The "Default Local System Properties" panel opens.

| ing C ot - (&} ction Settings
¥ Accept Socket Connections I” Force Yiew Only [disable Yiewers Inputs)

Password: I Disable Local Inputs [Keyboard & Mouse]

¥ Remove Desktop Wallpaper

Display Number or Ports to use & Auto

¢ Display N° |0 i Update Handling
© Ports  Main: 5900 Hup: (5800 W Paoll Full Screen [ Fast] e sonsnl

| v Poll Foreground Window—]| ::;;l:;:';:l:l‘y

I~ Poll Window Under Cursar * Received Only

¥ System HookDII
¥ Video Hook Driver

MS Logon

¥ Enable Java Viewer (Http Connection)
¥ Enable Xdmcp (X11 Connection)

—¥¢/hen Last Client Di: I Low Accuracy [ Turbo Speed]
©/0uiNothing - DSM Plugin
" Lock Workstation [W2K] I~ Use iNn Plugin detected... j Config

7 Logoff Workstation

~Share only the Window Named :

Misc.
¥ Enable Blank Monitor on Viewer Request I" Share ]
¥ Enable File Transfer Query on i
" Log debug infos to the Win¥NC.log file ’7 I~ Display Query Window Timeout:{10 5
I~ Allow Loopback Connections L
Default Server Screen 1 F 0K Apply | Cancel |
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5. Enter a password with a length of at least five digits.
This password is used on the remote computer to access the instrument. Other
settings may be changed according to the user-specific security requirements.

After the installation the Ultr@VNC program is automatically started together with
the operating system. On mouse over, the IP address of the instrument is indica-
ted.

This IP address and the user-defined password are the prerequisites to enable
remote access on the remote computer. Terminated connection is indicated by
changed icon color.

Configuring Internet Connection Firewall for VNC Connection

To enable remote access of an instrument in a local network via VNC connection, the
connection must be specifically permitted in the firewall.

1. Press the "Windows" key to access the operating system and select "Start > Set-
tings > Control Panel > Windows Firewall" to open the "Windows Firewall".

2. Select "Exceptions > Add Program... > Run Ultr@VNC SERVER" and confirm with
IIOKII.

(‘Add a Program &

To allow communications with a program by adding it to the Exceptions list,
select the program, or click Browse to search for one that is not listed.

Erograms:

@ Calculator

[TIMS lagon test utity
[ Notepad

= On-Screen Keyboard
1 Paint
=

=

= : -
& Run U@VNC VIEWER

m Upgrade
@Wlndows Explorer
[ wordPad
Path: |C:\Program Files\UIliaVNCiwinme exe | [ Browse. ]

3. Inthe "Exceptions" tab, enable "Run Ultr@VNC SERVER".
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@ Windows Firewall ﬁ

| General| Exceptions |Advanced)

“windows Firewall is turned off, Your computer is at risk of attacks and intrusions
from outside sowces such as the Intemet. We recommend that you clck the
General tab and select On.

Programs and Services:

Name
(] Component of Software Platform: ComponentE nvironmentServer
[ File and Printer Sharing
[ Message Queuing

[ Remote Assistance
ClRemote Desklop
MU Dk@VNE SERVER |
CJUPRP Framework

[MdProgau J [ ..;.ddPg.rt:, ] | Ed;t... : ] [ Q;ete-

Display a notification when Windowss Frewall blocks a program

Wadhat are the ngke of allowing exceptions™

Cancel

Installing the VNC Viewer on a Windows PC

1.

2.

Download the Ultr@VNC program form internet and follow the installation instruc-
tions.
Only the program component VNC Viewer is required.

Note: The VNC Viewer program is included in the download for the installation of

the Ultr@VNC program on the signal generator if "Full installation" was selected in
the "Select Component" panel. In this case, the program ultr@vncviewer.exe

can be copied to the Windows PC.

Install VNC Viewer program component on the remote computer.

Setting up the VNC connection on the Linux/Unix remote computer

The VNC program is available per default for Linux/Unix operating systems.

1.

Start a Web browser on the remote computer and enter the IP address of the
instrument.

Enter the following address:
vnc://<IP-address of the instrument>, e.g. vnc.//192.168.1.1.

A dialog is opened and the password for the remote VNC connection is requested.

Enter the password as defined in the "Default Local System Properties" panel of
the Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual func-
tions are operated using the mouse and keyboard.

In contrast to remote access via Remote Desktop, the direct control of the instru-
ment is not disabled and the instrument can be controlled from the front panel and
via the remote computer alternately.
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Setting up the VNC connection on the Windows remote computer

1. Start VNC Viewer program component on the PC, select "VNC Server" and enter
IP address of the instrument.

M NCServer [192716610 I |
i { host:dizplay or hosk: part |

 Buick Options:
& AUTO [Auto select bast sattings) | Connect |

O ULTRA  [>2Mbitds] - Experimental

" LAN (> 1Mbit/s) - Max Colars

i MEDIUM  [» 128Kbit/s] - Max Colars

" MODEM (18- 12BKbit/s) - 256 Colors

£ 5L [« 19kKbit/s] - 256 Colars, Fuzzy

Cancel

I View Only I o Seaing Optons.. |
[~ Use DSMPhugin ]No Plugin detected... 'I Config
[~ Prosy/Repester |

2. Toinitialize the connection, select "Connect".

A message requesting the password appears.

¥MNC Authentication

3. Enter the password as defined in the "Default Local System Properties" panel of
the Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual func-
tions are operated using the mouse and keyboard.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be control-
led from the front panel and via the remote computer alternately.

Terminating VNC Connection

The remote access via VNC connection can be terminated either on the R&S AMU or
on the external PC. Terminating the connection does not disable it. It can be estab-
lished again any time. See the notice above concerning unauthorized access due to
VNC connection!

1. Terminate the connection on the R&S AMU

a) Press the "Windows" key to access the operating system.
b) Right-click on the VNC icon on the task bar and select "Kill all clients".

2. To terminate the connection on the external Linux/Unix PC, close the internet
browser or close the signal generator window.
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Using Virus-Protection Software

3. To terminate the connection on the external Windows PC, close the VNC Viewer
program.

The connection is terminated. The color of the VNC icon in the status bar of the
instrument changes.
A message on the external PC indicates the disconnection.

Disabling Remote Access via Ultr@VNC

The VNC connection can be disabled by removing the program on the instrument or by
deactivating the VNC Server service.

1. Remove the VNC program

a) Press the "Windows" key to access the operating system and open the "Add or
Remove Programs" by selecting "Start > Settings > Control Panel > Add or
Remove Programs".

b) Remove the VNC program.

2. Deactivate the VNC Server service

a) Press the "Windows" key to access the operating system and open the "Ser-
vices" by selecting "Start > Settings > Control Panel > Services".
b) Deactivate the VNC Server service.

The connection is disabled, the VNC icon disappears from the task bar of the
instrument.

Using Virus-Protection Software

Virus-protection software Symantec Antivirus 10.1.7.7000 has been successfully tested
for compatibility with the instrument software on R&S AMU.

However, Symantec Antivirus may affect the behavior of the instrument in terms of set-
tling time or stability. Symantec Antivirus 10.1.7.7000 has been subjected to detailed
tests with R&S AMU and a page file of 1024 MB. The system remains very reliable.
However, rare impact on the settling time has been experienced ( slight degradations
of settling time in 2% of samples out of specification).

Preparing the Installation of Symantec Antivirus

The installation is performed in the operating system.

Accessing Operating System

The operating system can only be accessed if an external keyboard and/or a mouse is
connected. Windows provides an on-screen keyboard that can be operated using a
mouse, thus enabling operation by mouse only. An external keyboard is recommended
for extensive entries.

1. Press the "Windows" key to access the operating system and open the "System"
dialog by selecting "Start > Settings > Control Panel > System".
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2. Inthe "System" dialog, select the "Advanced > Performance > Settings > Change".

3. Enable "Drive D: [DATA]" and "System managed size", confirm with "Set" and
close the dialog.

—
virtual Memory EE

Crive [Volume Label] Paging Fie Size {MB)

Paging file size For selected drive

Dirive: D: [DATA]
Space available: 11557 MB
O Custom size!

Initial size (MB):

Magimumn size (MB): | ]

“Total paging file size For all drives —
Minimum allowed: ZMB
Recommended: 381 M8
Currently allocated:  0MB
——

The Symantec Antivirus program can be installed.

2.9 LXI Configuration

LAN eXtensions for Instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology. LXI is
intended to be the LAN-based successor to GPIB, combining the advantages of Ether-
net with the simplicity and familiarity of GPIB.

Like GPIB, LXI determines and standardizes the way the instrument behaves in a LAN.
The LXI implementation by the Rohde&Schwarz signal generators allows you to
change certain LAN settings, to reset the LAN connection as well as to easy identifi-
cate the instrument.

LXI classes and LXI functionality

LXI-compliant instruments are divided into three classes, A, B and C, with the function-
ality of the classes hierarchically based one upon the other:
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Class A
L1 hardware trigger bus

Class B
|EEE 1588 synchronization

Class C
. Ethernet LAM interface
«  Wyeh server

+  RI1-11 protocol

. M instrurment driver

Class C instruments are characterized by a common LAN implementation, includ-
ing an ICMP ping responder for diagnostics. The instruments can be configured via
a web browser; a LAN Configuration Initialize (LCI) mechanism resets the LAN
configuration. The LXI class C instruments shall also support automatic detection
in a LAN via the VXI-11 discovery protocol and programming by means of VI driv-
ers.

Class B adds IEEE 1588 Precision Time Protocol (PTP) and peer-to-peer commu-
nication to the base class. IEEE 1588 allows all instruments on the same network
to automatically synchronize to the most accurate clock available and then provide
time stamps or time-based synchronization signals to all instruments with excep-
tional accuracy.

Class A instruments are additionally equipped with the eight-channel hardware
trigger bus (LVDS interface) defined in the LXI standard.

dard.org. See also "News from Rohde & Schwarz, article 2006/II - 190".

@ For information about the LXI standard refer to the LXI website at http://www.Ixistan-

Instruments of classes A and B can generate and receive software triggers via LAN
messages and communicate with each other without involving the controller.

The R&S AMU complies with LXI class C and provides an integrated "LXI Status" dia-
log for LXI status indication and reset of the LAN configuration (LAN Configuration Initi-
alize, LCI). To accesss the LXI Status dialog, press the SETUP key and select
"Remote > LXI Status".

For further information, see section "LXI Status" in the Operating Manual.

Firmware update
After a firmware update, shut-down and re-start the instrument in order to enable the
full LXI functionality.
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Default state of the network settings

According to the LXI standard, an LCI must set the following parameters to a default

state.

Parameter Value

TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled

ICMP Ping Enabled

Password for LAN configuration LxiWeblfc

The LCI for the R&S AMU also resets the following parameters:

Parameter Value

Hostname <Instrument-specific host name>
Description Vector Signal Generator
Negotiation Auto Detect

VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's "LXI Browser Interface".

2.9.1 LXI Browser Settings

To access the instrument via the web browser:

» Type in the instrument's host name or IP address in the address field of the
browser on your PC, for example "http://10.113.1.205".
Note: Do not add the missing zeros in the IP address, while opening the instru-
ment home page.

The instrument home page (welcome page) opens.
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LX1

* Lan Configuration

Status

Help

Glossary
Www.rohde-schwal Z.com

Instrument Home Page

Instrument Properties

Instrument Model
Mamufacturer
Serial Number

Description

LXI Class

LXI Version
Host Name
MAC Address
TCPIP Address

Firmware Revision

Current Time
Current Time source
VISA resource string

Device Indicator

Status

Mo error

RE&S AWMU 2004
Rohde & Schwarz GmbH & Co. KG
100001

Rohde & Schwarz Baseband Signal Generator
and Fading Simulator AMU200A 100001

c

14

100111157
00:ED:32:62.01.08
1011111 .57

02.05.108 beta (Release) (2008-04-24;
15:51:12), Compass 2.1.65.0 (Release)

Friday, 2008/04/25, 11:25:36
COperating System
TCPIP:10.111.11.57 :inst0:INSTR

© 2008 ROHDE&SCHWARZ. All rights reserved.

The navigation pane of the browser interface contains the following elements:
. llLXIIl

"Home" opens the instrument home page.
The home page displays the device information required by the LXI standard,
including the VISA resource string in read-only format.

— "Device Indicator" activates or deactivates the LXI status indication.
When activated, the LXI LEDs flash, both in the browser dialog and in the LXI
dialog of the connected instrument. A green LXI status symbol indicates that a
LAN connection has been established; a red symbol indicates that no LAN
cable is connected.

— "Lan Configuration" allows you to configure LAN parameters and to initiate a
ping, see Chapter 2.9.2.3, "Ping Client", on page 58.

— "Status" displays information about the LXI status of the instrument.

— "Utilities" provides access to the LXI event log functionality required by the LXI
standard.

® "Instrument Control"

"Web Control" provides remote access to the instrument, see Chapter 2.9.2.4,
"Web Control", on page 59.

® "Diagnostics"

"SCPI Remote Trace" records messages exchanged via the remote control
interface, see Chapter 2.9.2.5, "SCPI Remote Trace", on page 60.

. llHelplI
— "Glossary" explains terms related to the LXI standard.

Quick Start Guide 1402.5200.62 — 08 55
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— www.rohde-schwarz.com opens the Rohde & Schwarz home page.

> Press the "INACTIVE (press to toggle)" button to activate the connection.

ACTIVE prass to toggle) ]

A green flashing status LED indicates the active connection. If the LAN connection
fails, the LED turns red.

The status of the LAN connection is also indicated by the "LAN Status indicator" in
the "LXI Status" dialog.

For further information, see section "LXI Status" in the Operating Manual.

2.9.2 LAN Configuration

The "LAN Configuration" web page provides access to the parameters required for
identifying the R&S AMU in the network, and allows modification.

i

Password protection

Changing the LAN configuration is password-protected. The default password is Lxi-
Weblfc (notice upper and lower case characters). This password cannot be changed in
the current firmware version.

2.9.21

It comprises the following navigation entries.

| O7oTq) o U] x=1 1 o] o VO PPPUURTRN 56
Advanced LAN Configuration...........ccueeeeiiiiiieesiiiiiee s ciieee e seiieee et e e e s sveeeee e e 57
Lo IO 11T o | PP PRT PRSPPI 58
L ATZ= o T 7 0] o1 o RS 59
T 0 o B =T 4o (= I = Vo= TSP 60

IP Configuration

The "IP Configuration" page displays all mandatory LAN parameters.


http://www.rohde-schwarz.com/en/home_48230.html

LXI Configuration

29.2.2

éi\"_.‘
¥
ROHDE&SCHWARZ
LAN Configuration
LI LAN Parameters
Home
P Lan Configuration Hostname 10111.11.57
Advanced Config
Ping Client Domain
Status Description Rohde & Schwarz Baseband Signal Generato
Help TCPAP Mode | DHCP + Auto IP Address v
Gloscaiy IP Address 10.111.11.57
www.rolide-schwai z.com Subnet Mask 255,255.0.0
Default Gateway 10111001
1 4
DNS Server(s) 002168
10.0.23.153
Dynamic DNS O Disabled
® Enabled
| Reset | &1’.‘.“1’.’ [Passward
required!)
Status
Mo error

@ 2008 ROHDE&SCHWARZ. All rights resered.

The "IP Address Mode" selects a configuration mode for the IP address of the

R&S AMU. With static configuration, the entered IP address, subnet mask, and default
gateway are used. With dynamic configuration, DHCP or dynamic link local addressing
(automatic IP) are used to obtain the instrument IP address.

See Chapter 2.6.2, "Assigning the IP Address", on page 37.

Advanced LAN Configuration

The "Advanced Config" page provides LAN settings that are not declared mandatory
by the LXI standard.
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anDElSGHWARz LXI
LxI 4 LAN Parameters
Home
» Lan Configuration
IP Configuration
Advanced Config mDNS and DNS-SD MDNS & DNS-5D v
Ping Client
ICMP Ping enabled
Status
VXI-11 Discovery ]

» Utilities

Submit {Password required!)

Instrument Control
Web Control
Diagnostics
SCPI Remote Trace
Help

Glossary
www.rohde-schwarz.com

Status

Na error

2015 ROHDE&SCHWARZ. All rights reserved

The following advanced parameters are available:

® "mDNS and DNS-SD": The additional protocols "multicast DNS" and "DNS service
discovery" are used for device communication in zero configuration networks,
working without DNS and DHCP.

® "ICMP Ping enabled": Must be enabled to use the ping utility.
If you disable this setting, the instrument does not answer ping requests. The set-
ting does not affect the LXI ping client. You can ping other hosts from the instru-
ment, even if the setting is disabled.

e "VXI-11 Discovery": Must be enabled to detect the instrument in the LAN.
If you disable this setting, the instrument cannot be detected by the VXI-11 discov-
ery protocol mechanism. The setting does not affect other detection mechanisms.
Setting up a VXI-11 connection via the IP address or the host name is independent
of this setting.

Ping Client
The "Ping Client" page provides the ping utility to verify the connection between the
LXI-compliant instrument and another device.

The ping is initiated from the instrument. Using the 1CMP echo request and echo reply
packets, the function checks whether the communication with a device via LAN works.
Ping is useful for the diagnosis of IP network or router failures.

The ping utility is not password-protected.

To initiate a ping from the instrument to the device:
1. Enable "ICMP Ping" on the "Advanced LAN Configuration" page.
2. Select the "Ping Client" page.
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3. Inthe "Destination Address" field, enter the IP address of the device to be pinged
(without the ping command and without any further parameters), e.g. 70.713.1.203.

4. Select "Submit".

ROHDE&SCHWARZ
Ping Client
LxI Ping Parameter
Home
P Lan Configuration Destination
Advanced Config Address
Status Pinging 10.111.11.57 with 32 bytes of data: ~
Help ) Reply from 10.111.11.57: bytes=32 time<lms TTL=128
Reply from 10.111.11.57: bytes=32 time<lms TIL=128
Glossary Result Reply from 10,111,11.57: bytes=32 time<lms TTL=128
www.rohde-schwarz.com I Reply from 10.111.11.57: bytes=32 time<lms TIL=12%

Ping statistics for 10.111.11.57:
Packetza: ZSent = 4, Received = 4, Lost = 0 (0%
loss), ~

2.9.2.4 Web Control

The web control functionality provides remote operation via VNC using a Web browser
(with HTMLS5). This mode does not require additional installation or activation. The
VNC protocol allows simultaneous operation from several remote devices. The instru-
ment remains locally operable.

The GUI of the R&S AMU is visible. To perform the settings, you can operate the
instrument as with the manual control. The instrument controls are available via the
front panel simulation. File upload and download between the instrument and the
remote PC is also available.

Starting a Remote Control via the LXI web browser

This section assumes that the instrument and the controller PC are connected in the
LAN.

1. Start a web browser that supports html5 (W3C compliant).
2. Enter the IP address of the R&S AMU in the browser's address bar.
The R&S AMU's welcome page is displayed.

3. In the navigation pane, select "Instrument Control" > "Web Control".

Remote access to the instrument requires the password. The default password is
instrument.

4. Enter the password and confirm with the ENTER key.

After the connection is established, the current screen of the R&S AMU is dis-
played in the browser window.
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Use the mouse cursor and keyboard to access the functionality of the instrument

as you would directly perform the settings on the instruments front panel.

2.9.2.5 SCPI Remote Trace

The remote trace functionality allows you to trace input and output strings at the
remote control interface of the R&S AMU.

A recorded trace (message log) can be evaluated directly in the dialog. Use the high-
lighting and navigation functions provided in the lower toolbar to locate error messages
and messages containing arbitrary search strings. You can also export the message
log to a *. csv file and evaluate the file using a suitable program.

To trace and display messages:

1.
2.

In the navigation pane, select "Diagnostics" > "SCPI Remote Trace".

In the toolbar bar of the "SCPI Remote Trace" page, select "live mode" > "on" and
Illoggingll > “On".

"live mode > on" displays all commands and responses, and "logging > on" also
traces messages.

If you now control the R&S AMU with SCPI commands, using an appropriate tool,
the SCPI remote trace records the information sent and received.

Snocasonuans oo ||||m_

Lxi 4 SCPI Remote Trace

Home

» Lan Configuration
Status

» Utilities

live mode: @) on (off  logging: @ on (off | &7 fiter v logfile:  @irefresh | ¥ download | 3¢ clear [=] details

recMT| | |message

Instrument Control o = 1 *dn?

- < Rohde&Schwarz, <instrument, 12345 67890 >
opt?

a

Freq?

1000000000

LEV 20

LEV?

20

Web Control

Diagnostics

1
1
1
1
1
SCPI Remote Trace 1
1
1

coeoceoeo

Help

Glossary
www.rohde-schwarz.com

Status

20 live records received

© 2015 ROHDE&SCHWARZ. All rights reserved

The function records all sent commands, received responses and messages, and
stores them in an internal database. If "live mode" is disabled, you can display the
recent traces upon request, using the "refresh" button. You can also store the log in
a file.

Note: The diagnostics functionality will be extended in later releases, e.g. to down-
load or upload SCPI command files from / to the instrument.
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Toolbars

The toolbar at the top of the dialog provides basic settings and functions.

| live mode: (@ on (_)off logging: @ on (Joff | &7 fiter v log file: i@ refresh | ¥ download | 3 clear =] details |

® "Live mode" / "logging": If logging is switched on, messages are traced. They are
stored in an internal database and can be displayed upon request, using the
refresh button (live mode off) or they can be displayed automatically (live mode
on).

e "Filter": applies a filter to columns and/or rows when working (live mode off)
® "Refresh": reads the message log from the internal database and displays it
® "Download": stores the SCPI trace log to a * . csv file

e "Clear": deletes all message log entries in the database and on the screen

® "Details": displays details of the selected message, for example an SCPI command
in hex format (also possible by double\-clicking a message)

Columns
The following columns are available if no column filter is applied:

® "Rec": record number of the message within the message log
® |: number of the subinstrument

e "MT": indicates the type of the message. Possible values and related message
contents are:

— > =incoming command
— < =outgoing response to a query
— E = error message, highlighted by red color

— T = execution time, i.e. time required by the instrument to process the com-
mand internally

® "message": indicates the type of the message. Possible values and related mes-
sage contents are:

— > =incoming command
— < =outgoing response to a query
— E = error message, denoted in red

— T = execution time, i.e. time required by the instrument to process the com-
mand internally
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3.1

Brief Introduction to the Instrument's Concept

Getting Started

This section helps you to get familiar with the R&S AMU and provides an introduction
to the general concept of the instrument with a sample of the possible application fields
as well as a description of the main blocks in the signal generation flow.

This section also explains the operating concept in general and includes a brief intro-
duction to operation by a step-by-step description of the configuration. The example is
intended to provide a quick overview of the settings provided. No additional equipment
is required.

Brief Introduction to the Instrument's Concept

The R&S AMU provides an entirely digital baseband section for generating 1/Q signals.
The R&S AMU uses internal and/or external baseband signal sources and simulates
various interfering signals in the baseband, e.g. fading, noise and 1/Q impairment. Digi-
tal signals can be generated internally in accordance with several digital standards or
user defined signal characteristics. Analog or digital baseband signals can be fed into
the signal path. The signals are generated in realtime or with the aid of the Arbitray
Waveform Generator. The digital data streams can be output directly and are conver-
ted to analog I/Q baseband output signals.

The R&S AMU may contain two paths; through the user docmentation, the first being is
called path A and the second path B, respectively.

@ @

The signals generated in different basebands blocks can be routed from path A to path
B and vice versa and can be added. Each baseband path enables independent output
of the modulated signals (analog in/out, digital in/out, analog differential out).

For a detailed description of the blocks, refer to Chapter 3.3, "Baseband Section",
on page 70.

The operating concept of the R&S AMU employs the following three ways of instru-
ment control:

® Manual operation

® Remote control

® Remote access

Manual Operation

The R&S AMU can be entirely operated from the front panel. Peripherals such as
mouse or keyboard can be connected but are not essential.

The R&S AMU is equipped with an intuitive user interface. The central element of the
display is the block diagram that shows the signal flow and processing from the left on
the display to most right, i.e. the generated signal can be seen at a glance.
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Each block represents a functional unit of the instrument. Thus the user always knows
the position at which a parameter has an effect in the signal flow. The main settings of
a block are indicated in the block. The interconnection of employed inputs and outputs
is also shown. The user is thus always informed about the connection of inputs and
outputs in the signal flow and where they can be configured. A window is opened for
each menu where parameters can be set. When the window is opened, an entry is
made in the "Winbar" below the display. All open menus are of equal priority (not
modal) and can be accessed any time.

The block diagram in the figure below shows a fully equipped instrument.
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Figure 3-1: Block diagram of a fully equipped R&S AMU

With the aid of the rotary knob, the user can navigate in the block diagram and the dia-
logs, and can operate the instrument with one hand. The cursor is moved line by line
through the block diagram or dialog. Turning the button clockwise advances the cursor.
The selected block can be activated or deactivated with the TOGGLE key. Active
blocks are highlighted by a colored background.

The instrument comprises a comprehensive info and help system. Context-sensitive
help can be called any time with the HELP (F1) key. The help system indicates the cur-
rently selected parameter and offers additional services such as cross references,
index and contents. The content of the help system corresponds to the operating man-
ual of the instrument.

Warning and conflict messages caused by incorrect operation as well as further infor-
mation are displayed in the "Info" line. A complete list of existing conflicts is displayed
when the INFO (CTRL+I) key is pressed. Additional information on entries can be

requested from the help system. The history function permits display of all messages.

Assistants simplify the completion of tables. After data entry in the assistant, the table
is modified only after the "Accept" button has been pressed. Pressing the "Accept" but-
ton also stores the assistant data.
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For an introduction into the manual operating of the instrument, detailed operating
instructions and an overview of menus refer to Chapter 4, "Manual Operation”,
on page 87.

For an indepth description of the dialog boxes and the instrument functions refer to
section "Instrument Functions" in the Operating Manual.

Remote Control

Remote control is an operation of the instrument by means of remote control com-
mands or programs that automatize repeating settings. The instrument is connected to
a computer running the program.

The R&S AMU supports various remote control connections:

® Connecting the instrument to a (LAN) network

® Using the LXI browser interface in a LAN network

® Connecting a PC via the IEC-bus (IEEE 488) interface

ware Architecture) library provided for download at the Rohde & Schwarz website

@ Tip: For remote control over LAN, you can use the R&S VISA (Virtual Instrument Soft-
http://www.rohde-schwarz.com/rsvisa.

This way of operation and the instructions how to set up a connection for remote con-
trol are described in the operating manual, chapter "Remote Control Basics". The
description of the remote control commands is provided in the operating manual, chap-
ter "Remote Control Commands".

Remote Access

Remote access is the operating of the instrument from a remote computer. Both the
R&S AMU and the computer are connected in a LAN.

Remote access in contrast to remote control does not use remote-control commands
but a separate software which is installed on the remote computer. After its start, the
software simulates the user interface of the instrument. The instrument can thus be
operated from the remote computer as on the unit itself. The individual functions are
operated using the mouse and keyboard. Specific instrument functions can be execu-
ted using specific key combinations on the keyboard or a front panel key emulation that
can be operated with the mouse.

This way of operation and the instructions how to set up a connection for remote
access are described in Chapter 2.7, "Remote Access via an External Controller",
on page 40.

3.2 Applications of the Instrument

The modular design of the R&S AMU allows the instrument to be equipped with two
paths. This allows a multitude of applications to be performed for which several signal
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generators were previously required. Up to four baseband sources, two internal gener-
ators and two external inputs can be installed. A few examples are given below.
Possible applications:

® Generation of a baseband signal of different standards (realtime) or via arbitrary
waveforms

® Addition of real time signals of different standards, e.g. GSM/EDGE and 3GPP
FDD

® Baseband module tests with differential and digital signals
® BER Tests of baseband modules
® Design and tests of I/Q modulators

® (Generation of a wanted signal and an interfering signal for tests on baseband sec-
tions of receivers

® Generation of multicarrier signals with real time components up to 80 MHz band-
width

® Generation of fading and noise scenarios with external I/Q signals
® Signal Source for early development stage hardware simulators

® Development of new communication systems (e.g. LTE)

® Test of diversity techniques and real time baseband fading

3.2.1 Generation of Digitally Modulated Signals

The main field of application of the R&S AMU is the generation of digitally modulated
signals. In the instrument, a digitally modulated signal can be generated in several
ways.

Internally generated 1/Q signal

The 1/Q signal is generated internally in the R&S AMU. One or two baseband genera-
tors can be installed. The signals produced by the two generators can be added (possi-
bly with frequency offset).

In this case the instrument must be equipped with
® atleast one baseband generator (option R&S AMU-B9/-B10/-B11) and
® atleast one baseband main module (option R&S AMU-B13).

Fading scenarios can be created with the aid of a fading module (option R&S AMU-
B14, Fading Simulator) and option R&S AMU-B15, Fading Simulator Extension).

A digital/analog converter converts the internal digital baseband signals into analog 1/Q
output signals. The output of the analog signal can be single ended or differential
(option R&S AMU-B16; Differential 1/Q Output). For the digital signal output a base-
band digital 1/Q output (option R&S AMU-B18, Baseband Digital I/Q Output) is availa-
ble.
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Figure 3-2: Operation of the R&S AMU with I/Q signals generated by the internal baseband generator

Externally generated 1/Q signal

The 1/Q signal is generated by an external instrument and coupled in via the baseband
input module (option R&S AMU-B17, Baseband 1/Q Input (digital/analog)). With this
baseband input module, analog or digital signals can be fed into the R&S AMU. The
frequency of the signals can be shifted, and if options are installed for internal base-
band generation, the external and the internal baseband signals can be added with
variable level ratio. If the R&S AMU is equipped with a fading simulator (option

R&S AMU-B14, Fading Simulator and option R&S AMU-B15, Fading Simulator Exten-
sion), the signals can be faded. The fading module also processes external I/Q signals.
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Figure 3-3: Operation of the R&S AMU with externally applied I/Q signals.

3.2.2 One Path Instrument

A one-path R&S AMU requires at least one Baseband Main Module (option R&S AMU-
B13) and a signal source. The signal source may be either the internal Baseband Gen-
erator (option R&S AMU-B9/-B10/-B11) or the external Baseband 1/Q Input (option
R&S AMU-B17).
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Figure 3-4: Operation of R&S AMU with one baseband main module and two baseband sources.
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Additionally the following options can be part of a one-path configuration:

® Further baseband sources (up to a configuration with two internal Baseband Gen-
erators (option R&S AMU-B9/-B10/-B11) and one external Baseband I/Q Input
(option R&S AMU-B17))

® Addition of real time signals of different standards, e.g. GSM/EDGE and 3GPP
FDD

® Generation of multicarrier signals with real time components

® The Fading Simulator (option R&S AMU-B14) and the Fading Simulator Extension
(option R&S AMU-B15)

® Additive White Gaussian Noise AWGN (option R&S AMU-K62)

® Bit and Block Error Rate Measurement BERT (option R&S AMU-K80)
® One Differential I/Q Output (option R&S AMU-B16)

® One Digital 1/Q Output (option R&S AMU-B18)

One-path instruments cannot use a second external Baseband 1/Q input option.

3.2.3

Two Path Instrument

A two-path R&S AMU requires at least two Baseband Main Modules (option

R&S AMU-B13) and two signal sources. The signal sources may be the internal Base-
band Generators (option R&S AMU-B9/-B10/-B11) or the external Baseband 1/Q Inputs
(option R&S AMU-B17).
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Figure 3-5: Operation of R&S AMU as a fully equipped two-path instrument
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Additionally the following options can be part of a two-path configuration:

® Further baseband sources (up to a configuration with two internal Baseband Gen-
erators (option R&S AMU-B9/-B10/-B11) and a second external Baseband 1/Q
Input (option R&S AMU-B17))

® Addition of real time signals of different standards, e.g. GSM/EDGE and 3GPP
FDD

® Generation of multicarrier signals with real time components

® The Fading Simulator (option R&S AMU-B14) and the Fading Simulator Extension
(option R&S AMU-B15)

® Additive White Gaussian Noise AWGN (option R&S AMU-K62)

® Bit and Block Error Rate Measurement BERT (option R&S AMU-K80)
® A second Differential 1/Q Output (option R&S AMU-B16)

® A second Digital I/Q Output (option R&S AMU-B18)

Baseband Section

The baseband section of the R&S AMU is fully digital and contains the hardware for
generating and processing 1/Q signals.

The baseband section may contain two paths.

For detailed information on available options, refer to the R&S AMU data sheet and the
R&S AMU configuration guide.

Up-to-date information is available at R&S AMU homepage on the internet http://
www.rohde-schwarz.com/product/amu200a.html.

Baseband generator (option R&S AMU-B10)

The generator produces baseband signals. It contains modules for real time signal
generation and an arbitrary waveform generator (ARB).

The different baseband options feature a different ARB memory size (see data sheet).
But apart from the memory size, all options have the same functionality and are instal-
led alternatively.

One or two baseband generators can be fitted in an R&S AMU and operated sepa-
rately. Signals from the baseband generators can be routed from path A to B and vice
versa, and added (possibly with frequency offset).

The option Baseband Generator contains real time Custom Digital Modulation and
ARB. Software options providing various digital standards are offered in addition.
Option R&S AMU-K40, for instance, generates signals to GSM/EDGE standard, option
R&S AMU-K42 signals to 3GPP FDD standard.

Baseband input module (option R&S AMU-B17)

With the aid of this module, external analog or digital I/Q signals can be fed into the
R&S AMU. For two-path instruments, an external signal can be connected to baseband

[
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Baseband Section

path A or path B. For one-path instruments, the baseband input module is permanently
linked to path A. Up to two baseband input modules can be applied. In two-path instru-
ments the signal of the first baseband module can be routed to path A, path B or to
both paths. The signal of the second baseband input module is firmly connected to
path B. External and internal baseband signals can be added with variable level ratio.
The 1/Q signals can be further processed: e.g. the frequency of the signals can be shif-
ted, noise can be added and they can also be faded.

The R&S AMU-B17 option can be used together with the R&S® EX-IQ-BOX digital
interface module, providing a versatile digital baseband interface with various formats.

The baseband main module can be installed twice, for each of both paths A and B
respectively.

The module converts the digital signal to an analog I/Q signal and routes it to the 1/Q
output. The analog 1/Q signal can be output either single ended, or differential.

This module also offers digital 1/Q impairment functions. The 1/Q signal can be deliber-
ately corrupted, e.g. for testing the receiver quality.

All frequency and time settings are coupled to the internal reference frequency.

Additional White Gaussian Noise (option R&S AMU-K62)

Additive white noise, which may be required for instance for measurements on mobile
radio base stations, can be produced with the AWGN software option (R&S AMU-K62).

If the noise generator is used, a frequency offset cannot be added to the wanted sig-

6 nal. If two options R&S AMU-B13 are installed (paths A and B), AWGN can be gener-
ated either on path A or B with one R&S AMU-K62 option. If AWGN is to be generated
on paths A and B simultaneously, two options R&S AMU-K62 must be installed.

Fading module (option R&S AMU-B14)

This module enables fading effects to be produced on baseband signals in real time. In
the case of TDMA fading, up to 20 fading paths (40 fading paths with option
R&S AMU-B15) can be created simultaneously.

Software option R&S AMU-B71 comprises the 3GPP dynamic fading configurations
moving propagation and birth-death propagation as well as the fine delay fading config-
urations offering enhanced delay resolution.

R&S AMU-B14 and the R&S AMU-B15 are installed (signal path A and B), dynamic
fading and enhanced resolution can be used either on signal path A or B with one
option R&S AMU-K71 option. If dynamic fading and enhanced resolution is to be used
on signal paths A and B simultaneously, two options R&S AMU-K71 must be installed.

6 At least one fading simulator, option R&S AMU-B14 must be installed. If both options
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Differential output module (option R&S AMU-B16)

The differential output module (option R&S AMU-B16) provides symmetrical signals for
differential outputs. The operating points of the inputs can be set and balanced by an
offset between inverting and non-inverting output. This module can be installed twice
(for path A and path B).

Digital output module (option R&S AMU-B18)

The R&S AMU can be equipped with a standardized digital I/Q interface (LVDS) for
online transfer of digital I/Q data. The digital output module (option R&S AMU-B18)
enables the digital output of the I/Q baseband signal.

This module can be installed twice (for path A and path B).

The R&S AMU-B18 option can be used together with the R&S® EX-IQ-BOX digital
interface module, providing a versatile digital baseband interface with various formats.

3.3.1 Description of Individual Diagram Blocks of the Baseband Section

The baseband section of the R&S AMU comprises two paths (paths A and B). There-
fore, if two baseband generators are available, two baseband signals can be pro-
cessed independently of each other. Routing from path A to path B and vice versa is
also possible, but not after the "IMP" or "AWGN/IMP" block.

toggling).
The ON/OFF TOGGLE key at the front panel (see "TOGGLE" on page 15) switches
the currently selected block on or off.

6 Each function block can be activated or deactivated with the "ON" check box (on/off

A detailed description of the blocks is provided below.

Baseband a] Baseband A block

config... In this block, the (first) baseband source is configured and activated. The block is dis-
I~ on played only if a baseband generator is available in the instrument.

o Depending on the installed software options, various digital standards, user-configured

digital real time modulation or the built-in waveform generator (ARB) can be selected.
The selected modulation is displayed in the block.

BB Input External Baseband In block
conly... | This block controls the baseband input module for external 1/Q signals. The block is

™ On displayed only if the baseband input module (option R&S AMU-B17) is installed. Exter-
nal I/Q signals can be applied to the analog I/Q input. The output of the baseband input
module can be connected to baseband path A or (if available) path B provided at least
one baseband main module or one fading module is installed. Otherwise the baseband
input module is permanently linked to path A. (The reason is that the baseband input
module does not contain a router chip. For switchover, at least one baseband module
with a router chip is required).
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Note: If one baseband path is configured (path A), the external baseband signal BB
Input B is connected to this path. If two baseband paths are configured the external
baseband signal BB Input B is permanently routed to path B.

PasebandbB] Baseband B block

config._. Configures the second baseband source (if installed). The block is displayed only if the
™~ on instrument contains two baseband generators. Depending on the installed software

DIELIE option, various digital standards, user-configured digital real time modulation or the

built-in waveform generator (ARB) can be selected.

Note: If two baseband generators are installed and two signals of the same standard
(e.g. GSM/EDGE) should be output simultaneously, the two associated software
options must also be installed (in this case R&S AMU-K40).

If only one R&S AMU-K40 is installed and GSM/EDGE is selected in the first baseband
generator, the second baseband generator is disabled for GSM/EDGE.

However, a software option is not tied to a specific baseband generator. In our exam-
ple, either the first or the second baseband generator can output a GSM/EDGE signal.

Fading A Fading block
e | This block controls the fading module. It is displayed only if a fading simulator (option
™ On R&S AMU-B14) is installed. Signal routing at the output of the fading module is also
Std Del configured in this block.

For instance, two-channel fading can be selected if the instrument contains two base-
band paths and two faders (option path extension, R&S AMU-B15).

Note: Under certain signal routing conditions only one fader can be activated

At least one fading simulator, option R&S AMU-B14 must be installed. If both options
R&S AMU-B14 and the R&S AMU-B15 are installed (signal path A and B), dynamic
fading and enhanced resolution can be used either on signal path A or B with one
option R&S AMU-K71 option. If dynamic fading and enhanced resolution is to be used
on signal paths A and B simultaneously, two options R&S AMU-K71 must be installed.

awennme A AWGN/IMP A block
BT In this block (digital) I/Q impairments for the baseband path can be set. With the aid of
[ On the software for AWGN generation (option R&S AMU-K62), an (additive) noise signal
can be produced.

AWGN and impairments can be activated independently of each other in the appropri-
ate menus. The settings are displayed in the block. The entire block can be activated
or deactivated. If the block is deactivated, the signal passes through the block
unchanged.

AWGNI/IMP B AWGN/IMP B block
config... This block is displayed only if two baseband main modules (option R&S AMU-B13) are
[~ On installed. In this block (digital) 1/Q impairments for baseband path B can be set. With
the aid of the software for AWGN generation (option R&S AMU-K62), an (additive)
noise signal can be produced in path B.

If a noise signal should be applied to path A and B simultaneously, two software
options R&S AMU-K62 are required.
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Graphics Graphics block
BT With this block, the baseband signal (of path A or B) can be graphically displayed in
I~ On real time. The block is displayed only if at least one baseband main module is installed.

BERT BERT block

config... | In this block an integrated bit and block error rate tester can be set. The bit error tester
I~ on makes it possible to evaluate a signal demodulated and decoded by a DUT by measur-

ing the bit error rate. The data used to drive the DUT can be generated by the
R&S AMU or an user-defined external source. In addition, the block error rate mea-
surement can be used to verify CRC checksums.

1/Q Out A 1I/Q OUT A/B blocks
config... | These blocks are used to configure the digital and analog 1/Q outputs of path A. Con-
I on figurations like level display, output type, analog settings and digital settings can be
DIFF DI performed in the corresponding menus. | and Q components can also be swapped (I/Q
Swap).

The status line in a block displays the currently active output types, e.g. "DIFF DIGI"
denotes that the 1/Q baseband signal is provided by the analog output (in differential
mode) and also by the digital output.

Note: The BASEBD ON/OFF key switches the baseband output signal on and off. In
the two-path mode this key switches all signals off. A second stroke restores the status
that was active before the last switch off.

3.4 Example of Setup

This section provides an example on how to configure the instrument for generating a
fading signal in accordance with a standard GSM-TU 3 (12Path) and a carrier fre-
quency of 904.5 MHz (virtual RF).

Configuring and displaying a GSM-TU3 signal with fading

To generate and display the GSM signal, proceed as follows:

1. Activate default (preset) state.
Press the PRESET key to set a defined instrument state.

[
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Info

Sav/Rcl Handler Info -Preset in Progress

Baseband Fading AWGNINP | 1/0 Out
contig... | o | o | .| confio.. | | confi..  [F—lacur
I~ on i I on I T on I T on
MSK Std Del mp Ana —{ic 1@ out
ANA - BB Input Graphics BERT
LGN
config... | config... | config.. |
I on I on I on
= Graph A BERT
=

BERT

2. Select and activate the GSM/EDGE signal generation.
a) Turn the rotary knob and select the "Baseband A" block.

—— —
Baseband Fading AWGHN/IMP 1/Q Out
config... 5 config... | , | config... | .| config... | —{vaout
T on 1 T on Con | 7| on
MSK Std Del P Ana —|Exa-Box
- BB Input Graphics BERT
ram
config... config... config...
I~ on I~ on I~ on
S =



Example of Setup

b) Press the rotary knob to open the menu where the GSM/EDGE modulation can
be selected (different modulation modes are available depending on the
options installed).

Analog : 1 1 e :
uoao‘:.g- P_EPl 1 01](]] mv j Lm_ll 1000 mv EMF
! |

| TDMA Standards — &

[ COWMA Standards —
3GPP FDD...
CDMAZ2000...
TD-SCDMA...

| WLAN Standards —| —_——
|EEE 802.11 WLAN... Fading AWGNIMP 1/Q Out
IEEE 802.111... config... I CONig... I config... | —naour

I Beyond 36 Standards - ron I I'rom 21 T on
EEE S0 SR WA C Std Del MP Ana —{ bi 3 ouT
EUTRALTE...

|—— Satellite Navigation —|
GPS...

|— Broadcast Standards - _

m || FusTEREO.. Graphics BERT

XM-RADIO... config... config...

DVB... I~ on I~ on

= -Misc - BERT

Custom Digital Mod...

ARB...

Multicarrier CW...
Frequency Offset —
0.00 Hz =l
Phase Offset ——
0.00 dey =

[N A A

c) Turn the rotary knob and highlight "GSM/EDGE...".

BERT

—an._.m Stm wlands —a
CDMA Standdards —
3GPP FDD...

CDMA2000...

T oceTean

Press the rotary knob to open the "GSM/EDGE" dialog.

] oo 10000 e 10000 =

IGN/IMP 1/Q Out

Sequence Mode W config... —{va out
Symbol Rt o [voma smoarae =] [F o0 | 5
n or. Ana — ex-ra-BOX

Power RampiSlot Attenuations... Cosine /| 2.0 sym
Trigger/Marker... Auto /It |Fraphics ( BERT |

pnfig... config...
= I on I on
Clock... Internal BERT
Frame: Select Slot To Configure—————
)
BERT
a . PR SR S SR
==l | | | | | | |
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d) Turn the rotary knob to select parameter "State", press the rotary knob to
switch on GSM modulation with default settings.

= GSMIEDGE =3
|Slate ﬁ
Set To Defaut | SaveRecall... |
Data List Management... |
Sequence Mode I Framed {Single} j
ModulationfFifter... |
Power Ramp/Slot Attenuations... | Cosine / 2.0 sym
Trigger Marker... | Auto
Foneig >

Clock... | Internal

— Frame: Select Slot To Configure

L] 1 2 3 4 5 6 T

SaveRecall Frame... |

e) Press the DIAGRAM key to display the complete block diagram.

Tt e 1.000¢ e 1000v o
| e

Fading ((AWGN/MP | 1/Q Out
config... | config... | config... | —] va out
Fon |~ Y| Fon = I on
Std Del P Ana | Exra-sox
Graphics BERT
config... | config...
I~ on I~ on
BERT
S
BERT

To indicate the active state, the "Baseband" block is displayed in blue and the
checkbox "On" is ticked.

The entry in the Winbar indicates that the "GSM/EDGE" dialog is still open in
the background.
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f) To display the dialog in the foreground, press the associated softkey below the

"Winbar".
Analog
—5 w1000 s 1000v o
Info
Data List Management...
N/IMP 1/Q Out
Sequence Mode IWI config... v ouT
Symbeol Rate Mode Normal Symbeol Rate - On [~ on
§ Ana —|exvo-0x
ModulationfFilter... —
Power Ramp/Slot Attenuations... Cosine /| 2.0sym
Trigger/Marker... Auto [ Int praphics BERT
pnfig... config...
- I on " on
Clock... Internal BERT
Frame: Select Slot To Configure——— e
BERT
P T U S SR S B

GSWEDGE | | | | | | | |

g) Press the HIDE key to minimize the dialog again.
The "Fading", "AWGN/IMP" and "I/Q OUT" blocks are not yet active.

3. Configure and activate the fading standard GSM TU 3 (12Path).
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a) Turn the rotary knob and select the "Fading" block.

Marker 1. Frame
2: Frame
3: Frame
4 Frame

anar_ [ BB Input

I~ on

Fading AWGN/IMP 1/Q Out
config... .| config... config... —|motrr
" on ™ on — " on
Std Del imp Ana —] Exva-Box
Graphics BERT
config... config...
" on I~ on
BERT
S
BERT.

Press the rotary knob to activate the menu for fading settings.

Marker 1. Frame
2: Frame
3: Frame
4 Frame

—
Fading AWGN/IMP 1/Q Out
config... config... —] va out
I on Fon [ Fom
Std Del imp Ana —] Exva-Box
—
Graphics BERT
config... config...
I~ on I~ on
BERT
e
BERT
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b) Select Fading Settings, and press the rotary knob again to open the fading set-
tings dialog.

B Fading Q‘E\

SetToDetaun | saveRecall. | Standard GSM TU 3 (12Path) -|

General Settings

Configuration W Speed Unit 'h
Common Speed For All Paths F  Keep Constant E|
Signal Dedicated To W Virtual RF Im,m
Restart Event Aute = Restart |

Path Settings ‘

Path Table... | Path Delay Wizard... | Coupled Parameters... I Insertion Loss Configur ation... |

= 0] Gauss (0.1 1d)

|
00 os 10 15 20 25 a0 1 40 45 50 ss Delay | ps

c) Turn the rotary knob to select the Standard field.

State Off |

Set ToDefault | saveRecall.. | [standara Juser J
al Settings
Configuration W Speed Unit [kmim =]
Common Speed For All Paths  On Keep Constant | Speed |
Signal Dedicated To W Virtual RF [ 1.000 000 000 00 [aHz -]
Restart Event Auto = Restart |
pathTable.. |  PathDelayWizard.. | Coupled Parameters.| nsertion Loss Configuration... |

Static Path Rayleigh

-

=

20+

Sl VWM Dopp
Gauss (0.08 id) VWM Rice
Gauss (0.1 fd)

s
<

m
o
=
w
w
O ar
=
=
©
o

wn
o

g
00 01 02 03 04 05 06 o7r o0& 08 10 11 Delay [us

d) Press the rotary knob to open the "Standard" selection list.
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e) Select "GSM" by turning the rotary knob.

State Off

Set To Default | Save/Recall... | ISIandard |User 'II

al Settings User

Configuration I Standard Delay vl Speed Unit ‘ CDMA 3 vl

Common Speed For All Paths ¥ On Keep Constant ‘ Gk ' vl
NADC 3

Signal Dedicated To IBaseband Output vl Virtual RF ‘ PCH b GHz vl
Restart Event Auto - TETRA 3
3GPP 3

Path Table... | Path Delay Wizard... | Coupled Parameters..l ation...

5 WLAN 3

0 DAB »
% 10 WIMAX 3
-; i WIMAX-MIMO M Dopp
@ ;
e LTE b YU Rice
-
< LTE-MIMO 2
]
o

o
2

1XEVDO

|
00 01 02 03 04 05 08 07 08 08 10 11 Delay Ips

f) Open the "GSM" selection list, the select list GSM850/900 and select GSM TU
3 (12Path) in the same way.

ISIandald | User jl
Seingi———— User
Speed Unit ‘ CDMA » -

Keep Constant ‘m GSM400 >

NADC * GSMT00 v
Virtual RF
o "IN GsMTU 3(6Path)
Restc  TETRA b GSMIBO0  »  GSMTU 50 (6Path)

ettings e E GSM HT 100 (6Path)
WLAN »

Coupled Parameters... Ins¢ GSM RA 250 (GPath)
A & GSMET 50 (6Path)
e & GSM TU 3(12Path)
WIMAX-MIMO > EEHTUST (30
IE L GSMHT 100 (12Path)
AvCuUnn -

g) Press the rotary knob to confirm the selection.

IShndard | GSM TU 3 (12Path) j'

The fading simulation of the standard "GSM TU 3 (12Path)" is preset.
h) Turn the rotary knob and select the Virtual RF field.

] Fading

Set ToDefauk | Recall | standara GSMTU 3 (12Path) -

‘General Settings

Configuration Standard Delay = Speed Unit km/h =
Common Speed For All Paths I Keep Constant Speed =

Signal Dedicated To | Basenand outpur = vinal e | 1.000 000 000 00 | GHz _v_“

Restart Event Auto it Restart | ‘

Path Settings:
Path Table... | Path Delay Wizard... | Coupled Parameters... J Insertion Loss Configuration... | ‘

o StaticPath  Rayleigh
% 10~

o 2

14 ppler LOLT ]
&5 Gauss (0.08 fd) WM Rice
% 40- Gauss (0.11d)

5 5

0 g
00 05 1.0 15 20 25 30 35 40 45 50 s5 Delay [ us
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i) Press the rotary knob to activate the editing mode.

j) Enter the frequency value 904,5 MHz with the aid of the numeric keypad and
the unit keys.

I‘.'irlual RF | 904.500 000 00 IMHIL[I

k) Select the "State" field by turning the rotary knob.
[) Press the rotary knob to switch on the GSM fading simulation.

=S

Set To Default | SaveRecall. |  Standard [user -]

al Settings
Configuration W Speed Unit [kmm =]
Common Speed For All Paths # On  Keep Constant [ speed |
Signal Dedicated To [Baseband Outout  ~|  Virtual RF [ 1.000 000 000 00 [GHz -]
Restart Event Auto ~ Restart |
Path Table... | Path Delay Wizard... | Coupled Parameters..l Insertion Loss Configuration... |

0

Static Path Rayleigh

3

GaussDAB

Gauss Doppler  RY[UNT:T
Gauss (0.08 fd) WM Rice
Gauss (0.1 7d)

)
=

Path Loss / dB
g 5 2

1 1 1 1 1 1 1 I 1 1 1 1
00 01 02 03 04 05 08 07 08 0% 10 11 Delay Ips

m) Press the DIAGRAM key to display the complete block diagram.

B = 1.000) | e[ 1.000v o
| ]

Marker 1: Frame

2: Frame
3: Frame
4: Frame

AWGN/IMP 1/Q Out
) | com. | conng.. | comng... | contg.. || —provr
G —I= =T [ rom
IMP Ana —] exva-BOX

ANA'_ BB Input Graphics BERT
800 config... config... config...
™ on " on " on

BX-rQ

B lf BERT
ey
BERT

GSMIEDGE | Fading | | | | | | |

To indicate the active state, the "Fading" block is displayed in blue and the check
box "On" is ticked. The "I/Q OUT" block is not yet active. The entry in the "Winbar"
indicates that the "Fading" dialog is still open in the background. The dialog can be
displayed in the foreground by clicking on the softkey "Fading" in the "Winbar" or

by pressing the KEY below the "Fading" softkey. Press the HIDE key to minimize
the dialog again.
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4. Select and activate the 1/Q signal output.

a) Turn the rotary knob to select the "I/Q Out" block.

B w 1.0000 | 1.000v o

| o]

Marker 1: Frame

2: Frame
3: Frame
4 Frame

AWGN/IMP 171Q Qut
> PN N 5 O 5 RS

I~ on
mp Ana —'EK—VQ—BUX

AMA'_ BB Input Graphics BERT
vam
" on " on I~ on
EX-IQ
BOX lf BERT
fmnrf
BERT
= | | | | | |

b) Press the "config..." button to open the "I/Q Out Settings" menu.

- HE #w 1.0000 e 1.000v o
[ [ |

Marker 1. Frame

2: Frame
3: Frame
4. Frame

AWGN/IMP /Q Out Settings
fon > . cont. o
] ] I~ on Level Display Settings...
Imp Analog I/Q Output Settings...
Digital 'Q Output Settings...
ANAL BB Input Graphics BERT
am
config... config... | config...
I~ on I~ on " on
EX V0
BOX — BERT

e

c) Turn the rotary knob and select "Analog 1/Q Output Settings".

1iQ Out Settings
I'Q Out ON

I'Q Swap

Level Display Settings...

Digital 1iQ Output Settings...
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d) Press the rotary knob to open the respective dialog.

1/Q Output Type ISingeEnded v[

Load Type EMF -
Level Settings
Set Level Via PEP -

N T
Level Vrms [ ooy -]
crestfactor(s) | 000[B |
CrestFactor (s+hys) [ 0.00[ue ]

User Variation
Variation Active [~ on

Variation Step I 1.000 IV vI

1IQ Settings:
Couple 1/Q Bias r

=l

e) Switch on the analog I/Q output signal.

PR P -

f) Press the DIAGRAM key to display the complete block diagram.

tao w 1.0000 | 1.000v o

Marker 1: Frame

2: Frame
3: Frame
4: Frame

AWGN/IMP
1
> :>_|ﬁ:>{gu

mp —| exva-BoX

ANA'_ BB Input Graphics BERT
Vam i
" on ™ on " on

EX-ia

B = BERT
]
BERT

o | oo | g | | | | |
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To indicate the active state, the "I/Q Out block" is displayed in blue and the check
box "On" is ticked. The currently used outputs of the signal are indicated by the
output symbols of the | and Q components. The entry in the Winbar indicates that
the Analog 1/Q Out Settings menu is still open in the background. The menu can be
displayed in the foreground by clicking on the softkey "Analog 1/Q Out Settings" in
the Winbar or by pressing the KEY below the Analog I/Q Out Settings softkey.
Press the HIDE key to minimize the menu again.

5. Select graphics display of 1/Q signal.

a) Turn the rotary knob to select the "Graphics" block and open the respective
menu.

# Graphics Settings

I Path A

State Off
Gr: R

Smart Graphics [~ On

Bt Mode [+] =

.

Sample Rate Mode | Aulo 4
Sample rate 0.100

b) Select "State On" with the rotary knob to activate display of the 1/Q diagram.

The output signal is graphically displayed. It can be minimized and called the same
way as dialogs.

A, qity /- = d

Inphase ift)

0 200 40p 60y 8y 100

Quadrat. qft)

0 200 40p 50y a0y 1004
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4 Manual Operation

The R&S AMU can be operated intuitively either via the interactive block diagram or via
a menu tree. All menus are in the form of windows that can be operated in the same
way. Rotary knob, keys and softkeys, or alternatively a mouse, allow direct and there-
fore convenient access to entries and settings.

The clear-cut display shows the current signal generator state. Graphs, spectra, vector
diagrams, etc. can be called for a visual check of the output signal. Numerous help
functions support the user in signal configuration.

This section describes the concept of manual operation of the signal generator. This
includes a description of the general structure of a dialog box, working with dialog
boxes and the block diagram and the setting of parameters.

For an in-depth description of the dialog boxes and the instrument functions refer to
section "Instrument Functions" in the Operating Manual.

4.1 Key Features

The manual operating concept of the R&S AMU enables the user to make settings as
intuitively as possible and at the same time gives a permanent overview of characteris-
tics of the generated signal and of the current instrument state. Numerous online help
functions support user settings.

Block diagram
The block diagram is the core of the operating concept.

A graphics display shows the current configuration and the signal flow in the form of a
block diagram. All graphical elements can be accessed for operation. An element is
selected by means of the arrow keys and the associated setting function is called by
pressing Enter. Required menus and graphs are displayed on the block diagram which
is displayed again in the foreground whenever the DIAGRAM (CTRL+D) key is
pressed.

Permanent level display

The main characteristics of the baseband signal, PEP and level, are permanently dis-
played in the header section of the screen (status bar) and can be directly set in the
display fields by multiple pressing the BASEBD LEVEL key (CTRL+R). Changing one
of the values effects that the according value will be adjusted proportionally. Addition-
ally, auxiliary information on the parameters insertion loss or crest factor are displayed
for the corresponding paths.

Anslog ErestFﬂﬂ(gﬂ 0.00 ¢ 7 4[]|mv | LeveII §my B
ot [ vaour pep|  0.00]éers -| Level 10,00 eeFs
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Operation via Graphical User Interface

Functional blocks
Menus are assigned to the specific function blocks in the block diagram. The func-
tion blocks represent elements of signal generation. Function blocks displayed with
a blue frame can be directly switched on and off by means of the TOGGLE
ON/OFF (CTRL+T) key. The menus of the highlighted function blocks can be
called by pressing the ENTER key.
— Example:
The "Baseband" block contains all menus required for baseband signal config-
uration.

Baseband A

config... I
[~ On
DigMod

In this block all digital standards and the digital modulation can be selected.

— TDMA standards —]
GSMEDGE...
— CDMA standards —]
3GPP FDD...
misc
i Custom Digital Mod... :
ARB...
Multicarrier CW...

Signal flow
The signal flow between the function blocks and the employed inputs and outputs

are also shown.

harker

1: =lat timing
2 =lat timing
usB [ |
- ﬂﬁs
Trig In 1 n

Menu tree

The menu tree can be opened and closed with the MENU (CTRL+M) key. The
menu tree is organized in the same way as the directories under Windows. The
function blocks correspond to the first directory level, the menus to subdirectories.

- TDMA standards -

GSMEDGE...
- CDMA standards
- 3GPP FDD...

Operation corresponds to the Windows concept

To offer the user a familiar environment, operation is very similar to operation of Win-
dows user interfaces. All menus and tables are made up of known elements, such as
selection lists, check boxes and entry fields.

A blue frame indicates that the selected item is active. In the highlighted element,
entries can be made.
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Rotary knob

o Operation is possible via front-panel keys, an external keyboard and the mouse. How-
ever, most of the settings can be easily made with the rotary knob:

® Turning the rotary knob shifts the entry focus to the target element.

® Pressing the rotary knob activates the selected entry field.
Depending on the parameter, the submenu is called, the numeric value varied, the
list entry selected or the check box activated or deactivated.

® |[f a value is entered, the entry is stored by another click on the rotary knob and the
editing mode is exited.

Clear settings with the aid of independent subdialogs

A separate window is opened for each dialog and subdialog. The dialogs can be oper-
ated independently of each other, i.e. none of the dialogs requires that settings in other
dialogs be completed before it can be closed. This ensures flexible operation at all
times.

]
Set To Def: =
Set To Default [ Isma it |
Mode
SaveRecall.. [ VQ Outputtype | Single Ended ]
Modulatiol | :
Simulation Mode : Load Type I EMF "l
Power Ramg| T BEaT o | alan Level Settings
Define All Slot Atte Pep Vp I 1.IJOIJ|V -vI
Winbar

The Winbar gives an overview of menus and simplifies their access.

The menus are displayed on top of the block diagram but they can be "hidden" with the
aid of the HIDE (CTRL+H) key, i.e. displayed in the form of a button in the "Winbar" at
the lower end of the screen.

They can be displayed again in full size by a keystroke (REARR (CTRL+A) key). This
makes room on the screen for other displays that may be required but the setting
menus can be still accessed any time.

i impair A| Analog 110 Out
‘ GSMEDGE A | GPS B | T | Setti a I | | ‘

Keys with assigned simple functions
Most keys on the front panel of the R&S AMU directly perform a simple function.

Since a great number of settings can thus be made by a keystroke, operation is easy.
For instance, the CLOSE (ESC) key closes the active menu; with the BASEBD
ON/OFF (CTRL+R) key the baseband output signal can be switched on or off

An exception are keys that call a menu such as the MENU (CTRL+M) key which opens
the complete menu tree of the instrument, the SETUP (CTRL+E) key which opens the
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menus for general instrument settings or the FILE (CTRL+S) key which opens the
menu for file management.

Help functions for user support

Numerous help functions support the user in signal configuration.

® Value ranges
The valid setting range is displayed for each numeric parameter. This requires a
short wait after activation of the entry field. The range is then displayed automati-
cally after a few seconds.

Roll Off Factor 30
More.  |Min=10.05
Max = 0.99
Power Ramp Conir{ "8P13te Mode o, ih0 11,00 sym

If the entered value is outside the permissible range, the next permissible value is
automatically set and a message is output.

® Context-sensitive help
Context-sensitive help for each parameter can be called with the HELP or F1 key.

QOperating the R&S Vector Signal Generator > Instrument Function > Baseband Signal -
Baseband Block > Digital Modulation - Custom Digital Modulation > Custom Digital Mod User
Interface > General Settings = State - Digital Modulation

State - Digital Modulation

Enables/disables digital modulation.
Switching on digital modulation turns off all the other digital standards.
In case of two-path instruments, this affects the same path.

The digital modulation is generated in realtime (no precalculated signal), and therefore all
parameter changes (in the ON state) directly affect the output signal.

SCPI command:

® Comprehensive online help
Each help page is part of a comprehensive online help function which can be
called by means of an index, a content tree or the "Previous/Next" buttons.

Info line with messages for indication of the current instrument state

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. With the aid of the
INFO (CTRL+I) key, help pages can be called for most of the messages. They provide
background information on the message and indicate operating steps that may be
required. All messages are explained in the online help which can be called with the
HELP (F1) key.

Digital | ouT Insertion PEP ’_L,

1/0 Out | OFF | et Loss --- 4B T&h| -6.74 dBFS LeveII -24.04 | dBFS

Analog [vaour| REF Crest Factor

T6 o | P (smus| 0.00 |¢B PEPI 0.951 Iv - Levell 0.150 v 50 0
ISav-"RcI Handler Info -Preset in Progress Info
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Graphical display of data structure

The structure of the baseband signal is graphically displayed in the respective menus;
the individual signal elements can be graphically selected for processing.

Frame: Select Slot to Configure

Graphics editor for definition of control signals

Control signals are also graphically configured.

B2 Slot Marker, GSM A (Frame 1 : Slot 0)

Tail Data s TSC s
3 57 1 26 1
Select Ramp to edit
SE— l
1 1 1 1 1 1 1
—Total List Length—j 0 50 100 Position / Bit
Length 157
Marker 1 Cursor Zoom Save—
Preset Type All down 1 || posit |_ Data Zoom In Save
ti 59
osition 57
Preset Edit Table... i isi
_presat_| PostioninData 56 || Bits Visible 150

Graphical display of output signal in a diagram

The output signal can be graphically displayed in a number of diagrams. This allows a
fast check of signal characteristics. Zoom functions and the insertion of a reference
trace permit in-depth evaluation without an external analyzer being required.

Inphase ift)

o 204 40p 60p 80y 1000

Guadrat. q(t)

0 200 40y 60y 80y 1000
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4.2

421

Display

Display

The display shows the current signal generator state and offers graphical elements for
direct operation. It is divided into three sections:

® The frequency and level display with info line indicates the main output signal
parameters and reports the current state with status, error and warning messages.

® The block diagram shows the instrument configuration, the signal characteristic as
well as the inputs and outputs used and permits interactive operation via graphics
elements. Active menus and graphs are displayed on top of the block diagram.

® Winbar with labeled softkeys for menu display.

The block diagram in the figure below shows a fully equipped instrument.

= Gefosor 1894 @ B 60|nv | leve| 30 @m
o Per| (.00 ders  Levell -10.79 BFs -
=
Marker 1: On/Off Rﬂl?ﬂ
T plew o g
4: On/Off Ratio u ; ] e ‘
' -
=) 3
o T el R a o i
v | EXU0-BOX
I%]* 0O  Patha
PO feoma. =1

o Qe
2ok HEE lhll’ilthi}mhil!l
| ! rrgrr M TlPllHﬂ'I

I

BXin =
- F BERT
. Fading BA |
g || & oo |2 feoma | oo |3
[~ on Iv| e
R
1: On/O7F Ratio EadinalHE EXJ0-BOX
2. On/OTF Ratio config... =
3: ON/Off Ratio T on

Marker 4: On/Off Ratio

BB Input
Settings A Settings A Settings B

Figure 4-1: Block diagram of a fully equipped R&S AMU

Settings Displayed in the Header Section

Level settings and a few status messages (see Chapter 4.2.2, "Status Information and
Messages", on page 93) are displayed in the header field of the screen. The display
may vary depending on the instrument's operating mode:

® |n case of two-path instruments, the baseband signal information on the two paths
is displayed separatelay for each path.

® PEP indicates the peak envelope power and Level indicates the output voltage at
the 1/Q output.

e Additionally, auxiliary information on the parameters insertion loss or crest factor of
the 1/Q output signal is displayed.
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4.2.2 Status Information and Messages

The instrument indicates status information and messages in the header section of the
screen. The messages differ with respect to their importance (errors, warnings, info)
and the time of their appearance (brief and permanent messages), and require differ-
ent treatment

For additional information refer to the info window (see Chapter 4.2.3, "Info Window",
on page 94).

Refer to "Error messages" in the Operating Manual for an overview of all status infor-
mation and messages and corrective actions.

4.2.2.1 Status Information

The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status information is displayed between the information on the current mode of the
baseband output signal and the level fields, at the left of the info line or in the info line
itself.

On two-path instruments, all states that can occur independently in the two paths are
displayed separately for each path. The associated path is indicated in the info line.
Analog Crest Factor,
(S5

e 186478 60w | tee] 30 m G

B %o PEP| -0.79 cers Levdl .1[]]9’@

ISa\n’RcI Handler Info -Preset in Progress Infnl

4.2.2.2 Messages

Messages indicate errors in the instrument. They are displayed in the info line in differ-
ent colors depending on their importance and display duration. Errors (e.g. no calibra-
tion data) are displayed in red, information (e.g. file not found) and warnings in black.
Warnings indicate less significant errors (e.g. the instrument operates outside specified
data).

4.2.2.3 Volatile messages

Brief messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument
(e.g. range violations). They are displayed in the info line on a yellow background.
They are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

Quick Start Guide 1402.5200.62 — 08 93
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These messages can be read from remote using SYST:ERR? or SYST:ERR:ALL?.

Permanent Messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signalled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

These messages can be read from remote using SYST : SERR?.

Info Window

A few operating states and the current message are displayed in the info line.

The INFO window with a list of current permanent messages and a detailed description
of each message can be opened with the INFO (CTRL+I) key.

[ A UCom, ALC-Aulo | B: ALC-Auto Cinfo 1 |nfo line
— -
.'] :"J"fl".']rf’“ - — List of current
[ E: " "'I' messages with
L FEnl 403 Efloname missing short message
* Info 0 SawRcl Manager Info: i -Recall ¢ text.
- No pending errors.
Detailed
description for
highlighted
message
Show
Delote | n-umll uuuu| | e

The upper section of the info window contains a list of all current permanent messages
in the order of their occurrence, i.e. the most recent message is displayed first. In the
lower section of the window, additional information on the highlighted message is dis-
played. A history of all messages that have occurred since instrument switch-on can be
called with the "History" key. The most recent message is displayed first.

The messages are color-coded according to their level. Device-specific messages are
red, info and remote control error are black. The level is also indicated in the "Lev"
column (Err, Sys or Info). Column "SCPI" indicates the SCPI error code.

With the aid of the softkey buttons, error messages can be cleared and a history of all
messages called.

Delete
Clears the highlighted message.

This button is available only if the history of the messages is displayed.

Delete All
Clears all messages.

This button is available only if the history of the messages is displayed.
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Del. volatile
Clears all volatile messages.

This button is available only if the history of the messages is displayed.

Remote command:

SYST:ERR:ALL?

Each time a SYST:ERR:ALL? query is sent, the error queue is returned and at the
same time cleared.

History

Calls the list of all messages that have occurred since instrument switch-on. The most
recent messages are displayed at the top of the list. When the button is pressed again,
the list of current messages is displayed.

Remote command:

SYST:ERR? Or STAT :QUE?

Each time a SYST:ERR? or STAT : QUE? query is sent, the oldest entry in the error
queue is returned and at the same time cleared in the list.

Block Diagram

The block diagram shows provided options, signal configuration and the currently
selected signal flow of the generator with inputs and outputs used. Signal generation
can be completely operated from the block diagram. The highlighted function block can
be directly switched on and off with the TOGGLE ON/OFF (CTRL+T) key. Pressing the
Enter opens the associated setting menu.

Marl\er 1; Frame
2 Frame
3 Frame corl'lﬂ....
4. Frame .
“ corlflﬂ--
:’>
—| DIG 1@ OUT
g s
R — o~ \
EX-IG-BOX “ / i confio.._|
ﬂ V)
BERT

DID

".

ANA
IJQNF

IKJN}_
1 Out B
_ | conig.. [|—wacur
[~ on
Ana —] Ex-ia-BOX

1. Unchanged
2 Unchanged
2 Unchanged
Marker 4 Unchanged

Figure 4-2: Block diagram of the R&S AMU

Function Blocks in the Block Diagram

Each block represents a function of signal generation. The function is indicated in the
headline of the block. In the check box, the respective function can be quickly activa-
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ted/ deactivated with the TOGGLE ON/OFF (CTRL+T) key. After activation, the block
is displayed in blue. Status information is displayed below the check box. It is different
for the different blocks.

Pressing the rotary knob (front panel) or the "Config..." button (mouse) opens the asso-
ciated setting menu.

In all function blocks where the signal flow can be influenced, the top menu level for
setting signal routing parameters is offered.

Example: Baseband block

— TDMA standards —

GSMEDGE...
— CDMA standards —
[v| JGPP FDD...
misc
Custom Digital Mod... :
ARE...
Multicarrier CW...

In this block, the digital modulation signal, the digital standards, arbitrary waveform
generation and multicarrier CW are set. The status information of the "Baseband" block
indicates the selected modulation and associated additional information, e.g. the num-
ber of channels.

4.2.4.2 Signal Flow and Input/Output Symbols in the Block Diagram

The input/output symbols in the block diagram show the currently used inputs and out-
puts of the signal generator. Unused inputs and outputs are not shown. The lines indi-
cate the signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.

Example:
| The symbols indicate the inputs for the analog | and Q signal on the
instrument front panel.
°
EX-IQ
aox I

If several markers are active, the marker characteristics are listed next to the marker
symbol of the active markers.

Symbols and lines are displayed in different colors depending on their function.
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Clock Marker 1: Restart

(=2 2 Restart
3: Restart
4. Restart

AWGN/IMP A :
conta. | | cont || :
5 L == o 5

| [naseme S

® The baseband signal is indicated by a three line arrow, the I- and Q-components of
the signal by a single-line arrow.

® Addition of signals is indicated by the summation sign.

® Connections are indicated by a "solder point".
® Black is used for the generated signal.
® Green is used for control signals.

The signal flow is configured in the individual menus. User interfaces are configured in:
® the "Setup > USER Marker /AUX I/O Settings" dialog and
® the "Setup > Global Trigger/Clock/External Inputs" dialog.

Winbar and Softkeys

The "Winbar" is displayed below the block diagram. Labelled buttons represent open
menus, the label indicates the menu. If several menus are open, the button of the cur-
rently active menu is displayed in a lighter colour. The buttons also assign functions to
the softkeys of the next lower level for front-panel operation. Up to eight menus may be
open simultaneously. When the ninth menu is opened, the menu that was opened first
is automatically closed.

i inipair A | Analog 110 Out
‘ GSMEDGE A ” GPSB | T | S, | | | ‘

Some menus, e.g. data and list editor menus, cover the "Winbar" and assign menu-
specific functions to the front-panel softkeys by way of the menu buttons.

Any of the open menus can be activated either with the respective button in the "Win-
bar" or the front-panel softkey. In combination with the keys for menu operation
(CLOSE (ESC), HIDE (CTRL+H) and REARR (CRTL+A)), convenient menu operation
can be ensured.

Working with menus and dialog boxes is described in Chapter 4.3, "Accessing Dia-
logs", on page 99.

Structure of the Dialogs

The parameters are set in the menus. Menus are accessed either via the function
blocks in the diagram or by means of the MENU (CTRL+M) key. The menus are dis-
played on top of the block diagram.

If the menu buttons assign menu-specific functions to the softkeys, the "Winbar" is hid-
den.
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Working with menus and dialog boxes is described in Chapter 4.3, "Accessing Dia-
logs", on page 99; the setting of parameters in Chapter 4.4, "Setting Parameters",
on page 100.

The menus are in Windows format. The menus differ in details depending on their
function but they consist of the same main elements. Each menu consists of a menu
header and one or more menu areas with various fields for setting parameters.

The header line contains the name of the menu and the buttons for minimizing and
closing the menu. To operate the buttons, use the mouse or the front keys HIDE
(CTRL+H) and CLOSE (ESC).

Several fields of associated but separately set parameters are organized in menu
areas. A menu area is framed and labelled with the function common to all parameters.

Example: Impairments

Impairments
State [
I Leakage | 0.00 % |
Q Leakage | 0.00 % |
Imbalance | 0.00 % |
Quadrature Offset | 0.00 ||:Ieg ﬂ

Each of the setting fields is assigned a parameter name. The kind of setting varies
depending on the parameter to be set. Some settings can only be made in a specific
configuration. If setting is not permitted with the specific configuration selected, the
respective item is disabled and displayed in gray and the entry or selection field cannot
be accessed.

4.2.7 Graphical Display of Output Signal Characteristics

The graphical display of the output signal enables the user to rapidly check signal char-
acteristics without connecting an analyzer. Zoom functions and the display of a refer-
ence trace allow in-depth evaluation. The diagram is displayed on top of the block dia-
gram. It can be minimized and called in the same way as a menu.

Example: 1/Q diagram

A At alf /.

Inphase ift)

o 204 40p 60p 80y 1000

Guadrat. q(t)

0 200 40y 60p 80y 100

Zoom
Run i
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To access the "Graphics Settings" dialog for selecting the graphics display of the out-
put signal, select the "Graphics" function block in the diagram or press the MENU
(CTRL+M) key.

Operation of the graphics windows is analogous to menu operation.

The menu and the individual graphical displays are described in "Graphics Display" in
the Operating Manual.

4.3 Accessing Dialogs
The MENU (CTRL+M) key opens the complete menu tree. Selecting a functional block
and pressing the ENTER key opens the menu associated with this block.

An alternatively way to access a dialog is to use the Winbar buttons or front-panel soft-
keys or to use the HIDE (CTRI+H), CLOSE (ESC), DIAGRAM (CTRL+D) and REARR
(CTRL+A) keys on the front panel.

For a quick access to the dialogs, use one of the following alternative methods.

Displaying the block diagram or a dialog in the foreground

1. Press the DIAGRAM (CTRL+D) key to move the cursor to the block diagram.

All active menus are minimized and displayed in the form of Winbar buttons.
2. Press the associated softkey (CTRL+F1 .. F8) to display the dialog in the fore-
ground again.
Accessing the menu tree

» Press the MENU (CTRL+M) key to open the complete menu tree.

Calling the File, Setup or Hardcopy dialogs

» Use the FILE (CTRL+S), SETUP (CTRL+E) or HCOPY (CTRL+Y) keys to open the
respective dialog.

Minimizing an active menu

» Use the HIDE (CTRL+H) key to minimize an active menu.

It is displayed in the form of a Winbar button.

Automatically arranging displayed menus

» Press the REARR (CTRL+A) key to rearrange all open menus so that they overlap
as little as possible.
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Activating the Winbar

» Use the WINBAR (CTRL+W) key to toggle the cursor between a button of the
"Winbar" and the block diagram.

The button that was active last in the Winbar is highlighted.

Closing an active menu

» Press the CLOSE key to close an active menu.

Tip: If the cursor is at the highest menu level, you can also use the ESC key to
close the active menu.

Accessing the header area

» Press the BASEBD LEVEL (CTRL+R) key to activate the "PEP" or "Level" entry
fields in the header area. Press the BASEBD LEVEL (CTRL+R) key again to switch
between the active input fields.

Keyboard Shortcuts

Keyboard shortcuts (e.g. "Ctrl + D" for the displaying the block diagram in the fore-
ground) provide direct access to all utility dialogs of the instrument (see Chapter 4.8,
"Legend of Front-Panel Controls", on page 121).

4.4

Setting Parameters

The R&S AMU offers several and sometimes alternative possibilities for setting param-
eters. Operation is possible from the front panel, with the aid of a mouse and/or from a
PC keyboard.

The examples whitin this description focus on the operation from the front panel.

O @

For more information, refer to:

® Chapter 4.8, "Legend of Front-Panel Controls", on page 121 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

® "Instrument Functions" in the Operating Manual for a detailed description of key
functions.

Most of the parameters are set in the different menus. The R&S AMU provides alterna-
tive ways for accessing the dialogs. Turn the rotary knob and navigate to the corre-
sponding block in the block diagram and press the knob to open the dialog or perform
a mouse click on the "Config..." button.
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An exception are the "Setup”, "File" and "Hcopy" dialogs. In the "Setup" dialog, general
settings are made which are not directly concerned with signal generation, e.g. setting
of the GPIB-bus address. In the "File" dialog, files and lists are managed; in the
"Hcopy" dialog, printout is configured and hardcopies can be made. These menus can
only be called with the SETUP (CTRL+E), FILE (CTRL+S) and HCOPY (CTRL+Y)
keys.

Level parameters are directly set in the header area of the display using the BASEBD
LEVEL key. Some of the keys trigger a direct action, e.g. the BASEBD ON/OFF key
switches the baseband output on and off. Changes affecting the signal flow are imme-
diately visible in the graphics display.

The R&S AMU uses the Windows Embedded Standard operating system. Settings at
system level are only rarely required, for example installation of a new printer driver.
For convenient operation, a keyboard and a mouse are required.

This section provides an information about the parameter handling that comprises of
the following main steps:

® Chapter 4.4.1, "Working with the Cursor", on page 101

® Chapter 4.4.2, "Selecting a Control Element", on page 102

® Chapter 4.4.3, "Switching Parameters On/Off", on page 102

® Chapter 4.4.4, "Entering a Value", on page 102

® Chapter 4.4.5, "Working with Units ", on page 104

® Chapter 4.4.6, "Selecting a Value from a List", on page 105

® Chapter 4.4.7, "Terminating Entries with Confirmation”, on page 105

® Chapter 4.4.8, "Restoring the Previous Value", on page 106

441 Working with the Cursor

After the instrument is switched on, the cursor is always on the first function block of
the diagram (default setting).

Moving the cursor on the display

> To move the cursor, use one of the following alternative methods:

a) Use the rotary knob or the arrow keys.

b) Use the appropriate softkeys (CTRL+F1..F8) to move the cursor to the "Win-
bar".
If the "Winbar" is covered by a menu, press the WINBAR (CTRL+W) key to dis-
play it in the foreground.

c) Use the ESC key.

Tip: Be aware that the function of the ESC key depends on the current cursor posi-

tion.

The function of this key depends on the current cursor position.

e Calls the next higher selection level.

e Closes the open window without accepting new entries; the old value or param-
eter is retained.

e In dialog boxes that contain a "Cancel" button it activates that button.
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Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or
to the previously highlighted block in the block diagram if no menu is active.

e Shifts the cursor from a function block in the diagram to the first item in the
"Winbar". If no menus are open, the current cursor position remains
unchanged.

Moving the coursor to the heading area

» Press the BASEBD LEVEL (CTRL+R) key to activate the "PEP" or "Level" entry
fields in the header area. Press the BASEBD LEVEL (CTRL+R) key again to switch
between the active input fields.

Selecting a Control Element
Control elements are always selected in the same way no matter whether a function

block in the diagram, a menu in the menu tree, a parameter in the menu or an entry in
a list or table is concerned.

» To activate an element, put the cursor on it.

ISource Ilnternal v"

An active element is highlighted by a blue frame.

Switching Parameters On/Off
A parameter can be activated and deactivated using a button or a check box.

1. Select the parameter.

2. To change the state of a parameter, use the "Enter" function of the different control
media:
e Press the rotary knob
e Press ENTER
e Press the TOGGLE ON OFF (CTRL+T) key.

Colour and label of a button change, the check box is ticked or the tick is removed.

Entering a Value

Numeric and alphanumeric values can be edited in the entry fields. In the editing
mode, cursors of different colour are used. A blue cursor indicates the overwrite mode,
a green cursor the insert mode.
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Changing between the Insert and Overwrite mode
The insert mode is the default setting.
Use the INSERT key to toggle between the insert and overwrite mode.

Numeric and alphanumeric values can either be newly entered or the existing value
can be changed. Incorrect entries are cleared with the BACKSPACE key.

Entering a new numerical value
1. Select the parameter.
2. Press a numeric key to activate the editing mode.

The previous value is cleared and the new value can be entered.

Editing a value in the insert mode (default setting)

1. Press the rotary knob (= Enter) to activate the editing mode.

If the cursor is placed at the right of the total value, the insert mode is always
active.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT
arrow keys.

The cursor is displayed in green.

3. Click on a numeric key to insert a new value.

Ehﬂ Rate ! 270.833 33 | ksymis »!l bol Rate | 270.883 33 [Kksymis =]
mnl Rate [ 270,620 333 | keymis vll ﬁw Rate T 270,068 33 | koymis v!l
=

Editing a value in the overwrite mode

1. Activate the editing mode.

2. Set the cursor on the numeric digit to be changed using the LEFT/RIGHT arrow
keys.

The cursor is displayed in blue and the number to be replaced is highlighted.

3. Click on a numeric key to overwrite the highlighted value.

{fsymbol Rate T 270 683 33 | keymis =] [jgymbot Rate T 270,668 33 | Koymis 'Il

Varying a value
1. Activate the editing mode.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT
arrow keys.

The value at the cursor position is varied.
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3. To vary the selected value, use the UP/DOWN arrow key or turn the rotary knob.

The value is increased or decreased.

Entering a new alphanumerical value
1. Select the parameter.
2. Press an alphanumeric key to start the editing mode.

The new value is entered.

Editing an alphanumerical value

An existing value, e.g. a file name, can be changed in the insert mode (see example)
or in the overwrite mode.

1. Select the paramter and activate the editing mode.

2. Set the cursor to the left of the alphanumerical value using the LEFT/RIGHT arrow
keys.

Tip: If hexadecimal values are to be entered, the numeric front-panel keys are
automatically changed to hexadecimal values.

3. Click on an alphanumeric key to insert a new alphanumerical value.

File Name: File Name:
McewList) meew | MccwList10.meew |

Terminating the entry of a numeric value

To terminate the entry of a numeric value:
1. Press the rotary knob (= Enter).
2. Press a UNIT key on the front panel.

3. Select a "Unit" in the selection field next to the parameter value.

Working with Units

The unit of a parameter is displayed next to the value. When the parameter is edited,
the unit is selected either from the list or by means of the front-panel keys. When the
entry is completed, the unit can be changed. In this case the value remains unchanged
but is automatically adapted to the new unit.

@

While operating the instrument by means of a mouse, assign the unit to the selected
parameter before entering its value.

Assigning a unit
To assign a unit to a value, use one of the following alternatives:

1. Press a UNIT key on the front panel.
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|eymbol Rate [ 14| [ ksymis =||+ @! = |lsymbol Rate | 14.000 000 00 |Msymss ~|

2. Select a "Unit" in the selection field next to the parameter value.
Press the ENTER key.

The unit displayed in the entry field next to the value is assigned.

Changing a unit

To subsequently change a unit, i.e. after the entry has been terminated and when the
editing mode is not active, use one of the following alternatives:

1. Press a UNIT key on the front panel.
2. Select"Unit" in the selection field next to the parameter value.

The value remains unchanged but the display is automatically adapted to the new
unit, i.e. the value is recalculated to suit the new unit.

B
[fsymbol Rate | 27083333 [ksymis =] + .' = flsymbor Rate | 0.270 833 33 [Msymis =[]

The new unit is indicated in the value field of the menu.

4.4.6 Selecting a Value from a List

Selection lists provide a list of predefined values for the selected parameter.

IMude |Framed {Single) jll
|Unframed |

SavefRecall Frame...

Modulation...

To select a item from a list, proceed as follow:
1. Press ENTER key to open the list.

2. Use one of the following alternatives to navigate through the list:

a) Turn the rotary knob or use the UP/DOWN arrow keys.
The selected item is highlighted.

b) Press TOGGLE ON/OFF key several times until the preferred entry is dis-
played in the selection field.

3. To confirm the selection, press the ENTER key.

4.4.7 Terminating Entries with Confirmation

The instrument behaves different by the termination of entries deppending on the
parameter type and the way this parameter is set.

[
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Confirming settings

» To confirm the settings, press the rotary knob or one of the UNIT keys (see also
Chapter 4.4.5, "Working with Units ", on page 104) .

Note: Variations by means of the rotary knob are immediately set.

Confirming multiple values

In some cases, like for instance when configuring the carriers for a multicarrier CW sig-
nal in a carrier table, it is useful first to enter few values and to confirm them together.
Such settings require additional confirmation. Not yet confirmed settings are displayed
on a yellow background as an indication that the currently displayed values do not rep-
resent the target signal.

» To confirm these settings, select the "Accept" button.

Confirming parameters with On/Off state

Most of the instrument functions with enabled and disabled states are calculated and
effective only after this functions have been enabled. However, there are functions like
the frequency variation of the reference oscillator for instance, that are immediately set
after confirmation.

» To confirm a parameter with On/Off state, enable the parameter.

If time-consuming calculations are required, signal generation is automatically switched
off and calculation is interrupted to allow the user to make further settings. Calculation
is restarted with the RECALCULATE key and the modulation is switched on again
when the calculation is completed.

Preventing recalculation

If an instrument function requires several parameter settings, switch the function off to
prevent a recalculation.

Enable the function after the entire configuration of the settings have been completed.
The signal is recalculated only once.

44.8

Restoring the Previous Value
Parameter variations with the rotary knob are immediately set and therefore not rever-
sible.

Normally, values cannot be restored in the case of mouse control because no explicit
confirmation is required in this case and entries are automatically confirmed when the
entry or selection field is exited.

Restoring values

In the case of front-panel control or operation from the keyboard, previous values can
be restored as long as the new value is not confirmed, i.e. the entry is not completed.

» To restore the values, press the ESC key.
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4.5

Restoring values that require confirmation

All settings that are not confirmed with the "Accept" button but require this additional
confirmation can be restored.

1. Press the ESC key.

A confirmation query is displayed.

I warning

You changed some parameter{s) which require a new calculation of the signal.
Do you really want to abort your changes without ACCEPT ?

OK Cancel

2. Confirm with "OK" to abort the changes.
Select "Cancel" to return to the dialog. The previous selected settings are dis-
played.

Restoring values after an extended calculation has been started

Calculation and setting might require different period of time. Many settings are made
without noticeable calculation times; such operations are indicated by a "BUSY" mes-
sage displayed in the status field of the header section.

A window with a progress indicates that the instrument performs an extended calcula-
tion that requires longer calculation time. The termination of such a calculation restores
the previous values.

» Press the ABORT button to terminate the calculation.

All previous values are restored.

Editors

The R&S AMU provides user-friendly editors for defining data lists as well as control
and marker signals.

Internally generated data lists can be used for digital modulation and digital standards;
the same applies to internally defined control and marker signals.

The lists are saved to files and may thus have any length. The file name of the lists and
the directory to which the files are saved are user-selectable. The file prefix is different
for each list type and is permanently assigned by the system.

For information about file handling and overview of the automatically assigned file pre-
fixes, refer to Chapter 4.7, "File Management", on page 115.

[
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4.5.1 Working with Data Editor

The "Data Editor" is used to internally generate binary data lists for digital modulation
and digital standards.

A list of binary values with a maximum length of 2231 bits can be entered in the "Data
Editor". This value corresponds to a file size of approx. 268 Mbyte. While it is being
processed, the file is continuously automatically buffered. When the dialog is exited,
the file is automatically saved with the new values, i.e. there is no extra "Save" button.
Depending on the size of the file, saving may take some time.

Editing an existing data list

1. To access a data editor and open an existing data list for editing, use the arrow
keys to select the associated button "Edit Data List... " in the individual menu.

The selected data list is displayed.

B Data list |Z| |§| ['5__<|

Offset 144, Len 144, dlist ins
01111 1111 1111 1111 1111 1111 1111 1111 1111 1111
40 1111 1111 1111 1111 1111 1000 0000 OOOO OOOO OOODOD
80 0001 1111 1111 0101 1111 1111 1111 1111 1000 0000

120 0000 1010 1000 0000 0000 o000 Ji

160

200

240

Start |

Goto | Select

The cursor marks the start value of the list.

To increase readability, the bits are displayed in groups of four. The current cursor
position, the length of the list and the list file name are displayed above the list. The
offset starts with the value 0 which corresponds to the bit position on the left side of
the first row, i.e. the beginning of the list. On the left edge of the editor, the last
three offset positions are specified at the beginning of the row.

2. Use the numeric keys to enter the values 0 or 1.
An existing list can be edited in the insert or overwrite mode. Use the INSERT key
to toggle between these two modes.

3. To delete a value, use the arrow keys to mark the bit that follows the value to be
deleted.
Press the INSERT key to activate the insert mode. Values cannot be deleted in the
overwrite mode.
Press the BACKSPACE key.

The value before the marked bit is deleted.

4. To select a bit position, select the "GoTo" button and press the ENTER key.
Enter the bit position in the "GoTo Offset" entry field by means of the numeric keys
and confirm the entry.

The cursor marks the bit at the selected position.

5. To copy and paste any range of bits at any position in the list:

Quick Start Guide 1402.5200.62 — 08 108



Editors

a) Use the the arrow keys to mark the start bit of the selection.

b) Select the "Start Select" button and use the the arrow keys to mark the selec-
tion.

c) Click the "Copy" button.

d) Navigate to the insert possition and select "Paste".

The selected and copied bits are pasted after the selected position.

6. To display and edit the values in hexadecimal form, select the "Hex" button.

Each four bits are displayed as a hexadecimal value: To increase readability, the
hexadecimal values in turn are displayed in pairs of two. The hex functions are
automatically assigned to the numeric keys at the front panel.

7. To save the data list, press the ESC key.

The list is saved automatically when the dialog is closed.

Creating a new data list

1. To create an empty data list, in the individual menu select "List Management >
Select Data List to Edit... > Create Data List" and enter the file name of the new
data list.

2. To open the data list for editing, select the associated button "Edit Data List..." in
the individual menu.

4.5.2 Working with Control and Marker List Editor

The control and marker signals for digital modulation and digital standards can be very
conveniently graphically defined in a "Control and Marker List Editor". The available
marker signals — and, with custom digital modulation, the CW, Hop, Burst Gate and
Lev Att control signals — can be defined in this editor.

While it is being processed, the file is continuously automatically buffered. Depending
on the size of the file, saving may take some time.

The various functions of the editor are explained in the individual menus. This section
focuses to the general use of the graphic editor.
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Example:

The following figure shows the "Slot Marker Definition Editor" of the "GSM/EDGE" dia-
log as an example.

E# Slot Marker GSM A (Frame 1 : Slot 0)

Data s TSC s Data
57 1 26 1 57
onfigure Control Signal: Select RamE to edit
Marker 1 v I 1 I|
Marker 2 ¥ -
Marker 3 [ -
Marker 4 [~ -
| I I | I I | I I I |
—Total List Length—— | 0 50 100 Position / Bit
Length 157
Marker 1 Cursor Zoom Save—
Preset Type All down 1 || posit |_ Data Zoom In Save
ti 59
osition 57
Preset Edit Table... i isi
LI Position in Data 56 D 150

The upper area displays the signal for which the marker signals are to be defined. On
the left side, the available signals (marker and control signals) are listed and colour-
coded.

Auxiliary functions are offered in the lower editor area, e.g. presetting for the ramps in
the marker signal, cursor positioning by entering the bit position and possible editing by
means of value entries in a table.

The actual graphic definition of the control signals occurs in the center area of the edi-
tor. Each control signal is represented by means of a colored line along the bit axis. A
cursor can be shifted alongside this line and marks the position where a ramp is to be
set. The color of the cursor changes depending on the current function.

Use the ENTER key to switch over between the colors (and therefore functions):

® Dblack: marks the bit position on the marker line

® yellow: sets a ramp

® green: activates the marked ramp for shifting.

Accessing control and marker list

1. To access the control list editor (e.g. "CList Dig Mod") and open an existing list for
editing, use the arrow keys to select "Custom Digital Mod > List Management >
Edit Control List".
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& CList Dig Mod A - c:/clist CE&E
Select Ramp o ol

Configure Control Si nals—.

Marker 1 I -
Marker 2 r - 3
Marker 3 r -
Marker 4 r - 3
Burst Gate -

Level Attenuation - ;

CW Mod

|

- (RTETTRTEY ARTETTRIT (RTETTRINA (RTETTRIN (RTRTTRNTE (RRTSTRATE (RRTSTRRTA (RRISTRNTE (RRISTRNTE NNTONIE
il (L i 0 100 200 300 400 500 600 700 Position / Symbal
Length 1000

Marker Cursor Zoom Save——
Preset Type All down ~| || Position |881 Zoom In Save
Preset Edit Table... Visible 150 Save As...

To access the slot marker list editor (e.g. "Slot Marker") and open an existing list
for editing, use the arrow keys to select "GSM/EDGE > Burst Editor > Slot Marker
Definition".

Editing an existing control or marker list

1.

Activate control/marker signal line for editing.
Use the arrow keys to mark the editable graphic area and press the ENTER key.
Select the control/marker signal line to be edit and press the ENTER key.

The cursor is active for the selected line.

Define the cursor position.
Select the parameter "Cursor Position", specify the position by means of the
numeric keys and confirm the entry.

The cursor is positioned according to the entry. If the entered value exceeds the
selected length of the definition range, the length is adjusted automatically.

Configure the control and marker signals (see "Handling of Ramps" on page 112).

Define length of control list ("Custom Dig Mod" only).
Select the "Total List Length" entry field and press the ENTER key. Enter the
length by means of the numeric keys and confirm the entry.

The control list length is defined.

Zoom displayed range ("Custom Dig Mod" only) in long control lists.

To zoom the displayed area around the current "Cursor Position", select the
parameter "Visible/Bits Visible", enter the number of symbols/bits to be displayed
by means of the numeric keys and confirm the entry.

Select the "Zoom In" button and press the ENTER key.

The selected number of symbols/bits around the current cursor position are dis-
played.
Ramps outside the displayed area are not lost by zooming.

Use the "Save"/"Save As..." function to save the edited control/marker list under its
current name or under a new name.
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Enter the file name in the "Create File" dialog and select the directory (see Chap-
ter 4.7.1, "File Select Dialog", on page 116).

Handling of Ramps

1.

Set a new ramp
Use the arrow keys or use the parameter "Cursor Position" to move the cursor to
the position where the ramp is to be inserted. Press the ENTER key.

The ramp transition of the newly set ramp depends on the current status (high or
low) of the control signal. If the signal is low, a ramp with low-high transition is gen-
erated; if the signal is high, a ramp with high-low transition is generated.

]

il |
4

When ramps are set between existing ramps, the transition of the new ramp is also
defined by the status of the signal before the new ramp. For this reason, a ramp
that has already been set can be assigned low-low or high-high transition (as in the
example), i.e. it will have no effect on the control signal in this configuration. How-
ever, the ramp remains saved, and its position is indicated by a dashed line.

| n

I

.._._
I IS

If another change produces effective transition, this ramp will be regenerated.

e WO 55
i o R s |
Shift a ramp

An existing ramp can be shifted to any positions. The transitions are adjusted
accordingly.

Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.

Press the ENTER key. The cursor again changes colour. The ramp will now be
shifted by means of the cursor. Press the ENTER key. The ramp will be set at the
current position.

The ramp transition depends on the status (high or low) of the control/marker sig-
nal before the ramp.

Delete a ramp

Use the arrow keys to move the cursor to the ramp position; the cursor changes
colour.

Press the BACKSPACE key.

The ramp will be deleted. The ramp transitions of the other ramps are adapted to
the changed signal status (high or low).

4. Setthe ramps in a table
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Select the "Edit Table..." button and define the positions and states of the ramps for
the selected marker.
Confirm the entries with "Accept".

5. Preset a marker signal
Select the "Preset" button to preset the marker signal.

The ramps of the selected marker are adjusted according to the selected "Preset
Type".
Creating a new control list

A new control list can be created under a new name either by generating a blank file or
by changing an existing list which will then be saved under a new name.

1. To create an empty control list, select "BB > Cust Dig Mod > List Management... >
Select Control List to Edit > Create Control List" and enter the file name of the new
control list.

2. To open the control list for editing, select the associated button "BB > Cust Dig
Mod > List Management... > Select Control List to Edit > Edit Control List..." and
select an existing control list.

4.6 How to Use the Help System

The R&S AMU is equipped with a context-sensitive help function. A help page is avail-
able for each parameter and can be called any time during instrument operation.
Calling context-sensitive and general help

» To display the general help dialog box, press the HELP (F1) key.

The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

& Help - State - Digital Modulation

Operating the R&S Vector Signal Generator > Instrument Function » Baseband Signal -
SetToDefi | Baseband Block > Digital Modulation - Custom Digital Modulation > Custom Digital Mod User
i Save/Reca| § |nterface > General Settings > State - Digital Modulation
i a Data Sourct
+-0j standard, §
+-( Modulation
+a Modulation
2 L3 Firter Enables/disables digital modulation.
-0 Power Ram
-3 List Manag¢ | Switching on digital modulation turns off all the other digital standards.
+a Data List Es
+ Eﬂ Control and|
+-0§ Power Ram | The digital modulation is generated in realtime (no precalculated signal), and thersfore all
+-3 TriggeriMan | parameter changes (in the ON state) directly affect the output signal
+ E]LArblllaryWavefon
+] Eﬂ External Baseband Si
E], Remote Control Basics I:
+-(3 Remote Control Commanq |
+ EL Maintenance
+ E[L Error Messages
+ El Hardware Interfaces
- Listof Commands
| | »

State - Digital Modulation

In case of two-path instruments, this affects the same path.

SCPI command:

g

Go To Index | Find Back Scroll Left Scroll Right Zoom In Zoom Out Hide Toc
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Contents of the help dialog box

The help dialog box contains two main areas:
® "Contents" - contains a table of help contents
® "Topic" - contains a specific help topic

The help system provides additionally an "Index" and a "Find" area, as well as "Zoom"
functions that are accessed by means of the corresponding buttons.

Navigating in the table of contents

1. To navigate within the table of contents entries, use the UP/DOWN keys. Entries
that contain further entries are marked with a plus sign.

2. To display a help topic, press the "ENTER" key.

The corresponding help topic is displayed.

Navigating in the help topics
1. To scroll through a page, use the UP/DOWN arrow keys.
2. To follow a cross-reference, select the link text.

3. To return to the previous page, select "Back".
This function scrolls back all steps that you have performed before.

4. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.

5. To maximize the "Topics" window, you can hide the contents tree with the "Hide
Contents" button, and vice versa.

Using the Index

1. Select the "Go to Index" button.

2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Press the ENTER key to change the focus.
4. Use the UP/DOWN keys to navigate and select the suitable keyword.
5. Press the ENTER key to display the help topic.

The corresponding help topic is displayed.

Closing the help window

» Press the HELP (F1) key.
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4.7 File Management

The R&S AMU uses files to save all instrument data, i.e. system and user data.

The user data includes saved instrument settings, data for the different digital stand-
ards as well as the waveforms for the arbitrary waveform generator.

The files are stored on the hard disk of the instrument. Drive D: \ can be used to save
user-defined data; any directory structure can be created on D: \. Some default direc-
tories are predefined, but can be changed at any time. The C:\ drive is a protected
system drive. The files on this drive contain data that must not be changed. Therefore,
this drive should not be accessed, since reconstruction of the system partition will lead
to data loss. To prevent inadvertent deletion or overwriting of system files, this drive is
not specified in the file menus. It can be accessed if a protection level (see section
"Protection Level" in the Operating Manual) is revoked.

Files can be exchanged either via a memory stick or a connected network. A memory
stick is connected to the USB interface and is assigned the E: \ drive. In the case of a
connected network, all network drives that can be accessed are available. The files are
accessed in a "Save/Recall" dialog in the individual menus.

The files are differentiated according to their extensions; each type of file is assigned a
specific file content. The extension is usually of no consequence to the user since
access to the files occurs in the individual menus where only the relevant type of file is
available. See Chapter 4.7.2.1, "Extensions for User Files", on page 119 for an over-
view of the supported file extensions.

The user data can be roughly divided into the following data types:

® Settings
Settings, e.g. the frame setting of the GSM/EDGE standard, can be loaded and
current setting saved to the specified file.

® Complex modulation and control data
User data of this type can be loaded. It can be generated either externally or inter-
nally. For internal generation, a new list must be created which will then be edited
in the data and control list editor. These functions are offered in the "Data List Man-
agement" dialog of the individual modulation menu.

® Waveforms
Waveforms are generated externally (e.g. by means of the R&S WinIQSIM2 pro-
gram that is supplied together with the optional Baseband Generator R&S AMU-
B10) and can be loaded in the "Arbitrary Waveform Generation" dialog.

@ Softkeys are assigned to some of the functions and can be used for convenient opera-
tion.
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For more information, refer to:

® Chapter 4.8, "Legend of Front-Panel Controls", on page 121 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

® to "Instrument Functions" in the Operating Manual for a detailed description of key
functions.

Accessing files with user data

1. To access an editable user data file, select the "Save/Recall" or "File Manger" func-
tion in the individual dialog.

Recall Settings
Save Settings
File Manager...

2. To access a loadable data file, select the "Select/New" or "File Manager" function
in the individual dialog.
Select Data List

New Data List
File Manager...

3. To access the "File Manager" function, press the SETUP (CTRL+E) key and select
"Save/Recall > File Manager".

A "File Select" window for loading, saving or creating a file or the "File Manager"
dialog for managing all files is displayed.

Saving and loading of all instrument settings
All instrument settings are saved and loaded in the "File" menu.

To access the "File" menu, press the FILE (CTRL+S) key.

For more information, see chapter "Storing and Loading Instrument Data - File Key" in
the Operating Manual.

4.7.1 File Select Dialog

The "Save/Recall" dialaog displays the available drives and directories. In the upper
part, "Recent Data Sets", the files last used are listed.
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B Save/Recall

& Save/Recall
Select Operation Save -
o1 usertissiARE Select Operation IRecaII v|
-8 _user =
% list = d:/AMU
B lists -
(3 ARB ﬁ[ c _I
d: J
- =% AMU
File Name: = ]
preset_settings I pm—m
Sa San s Fil ﬁl ARB
0| et | e s | araer. | -3 Digiconf B
Recall Recall Recall Recall File
mmediate| mmediate| mmediate| Manager..

The available drives and directories and the files of the selected directory are dis-
played. The currently selected path is displayed above the window. Only the relevant
files without file extensions are displayed. If the area is opened several times, the path
last selected is displayed. When a file is saved or created, its name is user-selectable;
the extension is assigned automatically and cannot be entered. The file is saved to the
selected path.

In addition to the files saved by the user, some menus also offer files containing prede-
fined contents. These files are saved to a specific directory on system drive; for this
reason, this directory cannot be chosen from the "File Select" menu.

Example:

The following example shows the "File Select" menu of the GSM/EDGE digital stan-
dard when "Recall Predefined Frames" is selected.

Recall Predefined frame &5 Recall Predefined Frame |T||E|[$_(|
Recall User Frame == -

Save User Frame
File Manager...

5 recent data sets
Edgel
EdgeAll

GsmEdge
HormalBurst0
HormalBurstall

Select | File
Manager...

Working with the File Select dialog

1. Access the "File Select" dialog (see "Accessing files with user data" on page 116).
2. Navigate in the "File Select" dialog.

3. Load an existing file.
In the "Recall Settings" dialog, mark a file and press the "Select" button.

4. Save afile.
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In the "Save Settings" dialog, enter file name in the "File Name:" field.
Select the directory to which the file is to be saved and then select the "Save" but-
ton.

5. Create a new file.
To create a new file, use the "Save Settings" functionality, i.e. specify file name and
directory and save the file.

The created file is empty; it must be filled with the necessary values in the individ-
ual editor.

4.7.2 File Manager

The "File Manager" allows general file management such as copying, shifting, renam-
ing and deleting files as well as generating new directories.

Thus, also externally created files, for example waveforms created by using the
R&S®WinIQSIM2 program, can be saved to the R&S AMU by copying them from a
memory stick or a network to the internal hard disk.

File Type All Files (*) v
= All Files (*) Pa
Instrument State (*.savrcl)
g _;;g;s ARB Waveform (*.wy)
- NRP Setting (*.nrp)
& _gsm List Mode List {*Isw)
EQ _lists User Correction {*.uco)
Q cust_dig_mod ARB Multicarrier Settings {*.arb_multcarr)
@ fading ARB Multisegment Info (*.inf_mswv)
Q fm ARB Sequencing List (*.wvs)
Q aps DigMod Data List (*.dm_igd) i
Q wimax
- winiasim2
w03 _sirius
=) _user
e tist
=% lists
&3 ARB

i~ clist_digmod.dm_iqc
i~ list_mode.lsw
-3 _wimax -

Create New

Cut | Copy | Paste | Rename | Delete | Directory

Use the "File Type" to select a file type from the list. This can be used to process either
all files (all files (*) selection) or a specific selection of files. See Chapter 4.7.2.1,
"Extensions for User Files", on page 119 for an overview of the supported file exten-
sions. The available drives and directories and the files of the selected directory are
displayed. The currently selected path is displayed above the windows. If the area is
opened several times, the path last selected is displayed. Unlike the "File Select" win-
dow, the "File Manager" displays the full file names including extensions.

Working with the File Manager dialog

1. Accessing the "File Manager" dialog (see "Accessing files with user data"
on page 116).

2. Navigating in the "File Manager" dialog.
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Operation is very similar to the operation of a standard Windows explorer.

3. Moving, duplicating, deleting or renaming files
To move a file, select the file and press the "Cut" button. Mark the directory to
which the file is to be moved and select the "Paste" button. If the target directory
already contains a file with the same name, a confirmation query is displayed to
confirm overwriting of this file.
Perform the similar steps and cut/copy/rename/delete the file.

Tip: The operation corresponds to the Windows concept.
4. Creating a new directory
Mark drive or directory level where the new directory is to be created, select the

"Create New Directory" button and enter the name of the new directory in the entry
window that opens. Confirm with ENTER.

4.7.21 Extensions for User Files

The following table lists all available file extensions for user files. The currently availa-
ble files on the instrument depend on the installed options.

Table 4-1: List of the automatically assigned file extensions in the instrument

Function/Digital List type Contents File suffix
Standard
Instrument State Settings Instrument settings *.savrcl
"Arbitrary Wave- Waveform ARB waveforms * LWV
form Generator™ ARB multi segment waveforms
Waveform ARB multi carrier settings *.arb multcary
Configuration | Configuration file for creation of multisegment *.inf mswv
data ARB waveforms
Play List ARB Sequencing List *.wvs
"DM" Data List Digital modulation data *.dm_iqd
*.tdm
Control List Data to control digital modulation *.dm_igc
Settings Digital modulation settings *.dm
User Standard | Digital modulation user standard *.dm_stu
User Mapping | Digital modulation user mapping * _vam
User Filter Digital modulation user filter * vaf
EX-1Q-BOX User Settings | EX-IQ-BOX User Defined Settings * . igbox
"Fading" Fading Fading data * . fad
"GSM/EDGE" Settings GSM/EDGE settings *.gsm
Slot User-defined slot data *.gsm_slu
Frame User-defined frame data *.gsm_fu




File Management

Function/Digital List type Contents File suffix
Standard
Slot Higher symbol rate slot *.gsm_hslu
Frame Higher symbol rate frame *.gsm_hfu
"Bluetooth" Bluetooth Set- | Complete setting of the Bluetooth menu *.bto
tings
"TETRA" TETRA Set- Complete setting of the TETRA menu * . tetra
tings
"3GPP FDD" Settings Complete setting of the 3GPP (FDD) menu *.3g
Settings Channel coding enhanced DPCH channels *.3g ccod dl g
(downlink)
Settings Channel coding enhanced DPDCH channels *.3g ccod ul
(uplink)
"CDMA2000" Settings Complete setting of the CDMA2000 menu * . cdma2k
"TD-SCDMA2000" | Settings Complete setting of the TD-SCDMA2000 menu | *.tdscdma
Settings Test Model for TD-SCDMA2000 * . tdtmd
1xEV-DO Settings Complete setting of the 1xEV-DO menu * . evdo
"IEEE 802.11 Settings Complete setting of the IEEE 802.11 WLAN *.wlan
WLAN" menu
"IEEE 802.11 n Settings Complete setting of the IEEE 802.11n WLAN *.wlann
WLAN" menu
Settings Beamforming data * . bmf
"IEEE 802.16 Settings Complete setting of the IEEE 802.16 WiMAX * . wimax
WIMAX" menu
"EUTRA/LTE" Settings Complete setting of the EUTRA/LTE menu * _eutra
Settings TDD Settings *.lte tdd
Settings User-defined IQ-File * . iqw
"GPS" Settings Complete setting of the GPS/A-GPS menu *.gps
Settings GPS Almanac Settings * . txt
*.alm
*.al3
Settings GPS Waypoints File * . txt
Settings GPS Generated Almanac File *rs_ al
*.rs_yuma
Settings GPS lonospheric File *.rs ion
Settings GPS Navigation Data *.rs nav
Settings GPS UTC File *.rs utc
*.rs_acq
"FM-Stereo" Settings Complete setting of the FM-Stereo menu * . fmstereo
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Function/Digital List type Contents File suffix
Standard
Settings FM-Stereo Group Type Settings *.fm gt
Settings FM-Stereo Group Hex Type Settings *.fm_ghex
Waveform File | Waveform File * . wav
"Sirius" Settings Complete setting of the Sirirus menu *.sirius
"XM-Radio" Settings Complete setting of the XM-Radio menu * . xmradio
Settings XM-Radio TWTA Data * . twta
"DVB" Settings Complete setting of the DVB menu * . dvb
Settings DVB Transport Stream *.gts
*.ts
*.trp
"DAB/T-DMB" Settings Complete setting of the DAB/T-DMB menu *.dab
Settings DAB ETI Files * . eti
*.xeti
NFC Settings Complete setting of the NFC menu *.nfc

4.8 Legend of Front-Panel Controls

The following table lists all key functions available on the front panel. Key combinations
used on the PC keyboard to trigger key functions on the instrument front panel are also
described. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 4-2: Cross-reference between the front panel keys and keyboard shortcuts

Front-panel key Key of PC keyboard Function

Turning the rotary Tab key (towards the right) | Sets the cursor with the rotary knob.

knob Shift + Tab (towards the left)

Pressing the rotary Enter Pressing the rotary knob confirms an entry; it has

knob the same function as the ENTER key.

Arrow keys Arrow keys Moves the cursor.

*1 /dB(m) ALT + F12 Confirms entries in the base unit and values with-
out a unit.

The unit dBm is inactive.

RV L H# Enters a period/decimal point. Enters a special
character.
+/- ] A<->a -/ (shift+) a—z Enters the sign.

Switches between upper-case and lower-case let-
ters.
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Front-panel key Key of PC keyboard Function

0-9/a..z CTRL+0-9/a...z CTRL Enters the number/letter.

BACKSPACE Backspace Clears the last entry (number, sign or decimal
point)

CLOSE CTRL+G Closes an active menu.

DIAGRAM CTRL+ D Sets the cursor on the block diagram and hides all
menus.

ENTER Enter Terminates an entry.

ESC ESC Selects the next higher menu/selection level. When

the editing mode is exited with ESC, the previous
value is restored.

FILE CTRL+S Activates the menu for storing instrument settings.
BASEBD LEVEL CTRL+ L Activates the frequency entry.
BASEBD ON/OFF CTRL+R Switches the baseband output signal on and off.

In the two-path mode the BASEBD ON/OFF key
switches all signals off. A second stroke restores
the status that was active before the last switch off.

"1/Q OUT OFF" is displayed in the status bar.

G/n / dBuV ALT +F9 Selects the unit Giga/Nano. The unit dBuV is inac-
tive.

HCOPY CTRL+Y Opens the menu for configuring and starting a
hardcopy.

HELP F1 Opens/closes context-sensitive help.

HIDE CTRL+H Minimizes the active menu. Pressing the respec-

tive button in the Winbar opens the menu again.

INFO CTRL + 1 Opens/closes the info window

INSERT Ins Activates the insert mode.

k/m / uVv ALT + F11 Selects the units Kilo/Milli and uV for levels.
LOCAL CTRL+Q Switches the instrument from remote control to

manual control.

M/u / uV ALT + F10 Selects the units Mega/Micro and uV for levels.

MENU CTRL+ M Calls the menu selection list.

ON/OFF CTRL+T Switches a block or parameter on/off.

TOGGLE Toggles between the different possibilities of set-
ting a selection parameter.

PRESET CTRL +P Restores a defined basic instrument setup.

REARR CTRL+ A Adjusts the size of the active menu to use the
whole height of the dislay.

RECALCULATE CTRL+C Starts recalculation of the signal.

SETUP CTRL+E Opens the setup menu for general instrument set-
tings.
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Front-panel key Key of PC keyboard Function

Softkeys CTRL + F1-F8 Triggers the function assigned to the softkey.

WINBAR CTRL+W

Front Panel Key Emulation

The R&S AMU provides a front panel key emulation to enable execution of the front
panel key functions by mouse e.g. for remote access. The emulation is called by a right
mouse click. The front panel key functions are executed by a mouse click on the asso-
ciated button.

Diagram
Fle |  Rear. |
preset |  WinBar |
e | __vep_|

On-screen Keyboard

In addition, the operating system provides a keyboard emulation that can be used for
system settings if no external keyboard but a mouse is available.

To access the on-Screen Keyboard, select "Start > Programs > Accessories > Accessi-
bility > On-Screen Keyboard".

= On-Screen Keyboard

File Kevboard Settings Help
esc F1| F2| F3| F4 [ Fs| Fe| 7| Fe B Fo | F1ol F11| F12 psc) (] brk|

Lo of T T T 1T Ll
(tob [afwlefrftfzfufifofpfa]+] # Jdei|endpan 7
o Jafsfafrfofnfifkfrfafa] en |

c|ly¥|bln|mj. -- shift + 1

SR o

S
P lan 0| ™~
[=r}
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GPIB Bus Interface

Annex
A Hardware Interfaces

This section covers hardware related topics, like pin assignment of the GPIB bus inter-
face, monitor and AUX I/O connectors.

The remote control interfaces are described in detailes in the Operating Manual, sec-
tion "Remote Control Basics".

All other interfaces are described in Chapter 2.1, "Front Panel Tour", on page 11 and
Chapter 2.2, "Rear Panel Tour", on page 19.

For specifications refer to the data sheet.

A.1 GPIB Bus Interface

Pin assignment
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Figure A-1: Pin assignment of GPIB bus interface

Bus lines

® Data bus with 8 lines DO to D7:
The transmission is bit-parallel and byte-serial in the ASCII/ISO code. DO is the
least significant bit, D7 the most significant bit.

® Control bus with five lines:



AUX I/0O Connector

IFC (Interface Clear): active LOW resets the interfaces of the instruments connec-
ted to the default setting.

ATN (Attention): active LOW signals the transmission of interface messages, inac-
tive HIGH signals the transmission of device messages.

SRQ (Service Request): active LOW enables the connected device to send a ser-
vice request to the controller.

REN (Remote Enable): active LOW permits switchover to remote control.

EOI (End or Identify): has two functions in connection with ATN:

— ATN=HIGH active LOW marks the end of data transmission.
— ATN=LOW active LOW triggers a parallel poll.

® Handshake bus with three lines:
DAV (Data Valid): active LOW signals a valid data byte on the data bus.
NRFD (Not Ready For Data): active LOW signals that one of the connected devi-
ces is not ready for data transfer.
NDAC (Not Data Accepted): active LOW signals that the instrument connected is
accepting the data on the data bus.

Interface Functions

Instruments which can be controlled via GPIB bus can be equipped with different inter-
face functions. The interface function for the R&S AMU are listed in the following table.

Table A-1: GPIB bus interface functions

Control character Interface function

SH1 Handshake source function (source handshake), full capability
AHA1 Handshake sink function (acceptor handshake), full capability

L4 Listener function, full capability, de-addressed by MTA.

T6 Talker function, full capability, ability to respond to serial poll, dead-

dressed by MLA

SR1 Service request function (Service Request), full capability
PP1 Parallel poll function, full capability

RL1 Remote/Local switch over function, full capability

DCA1 Reset function (Device Clear), full capability

DT1 Trigger function (Device Trigger), full capability

A.2 AUXI/O Connector

For an overview of the signals that can be applied at the USER connector, see section
"User Marker / AUX 1/O Settings" (table "USER Connector Signals") in the Operating
Manual.




AUX 1/O Connector

Table A-2: Pin assignment of the AUX I/O Connector connector

Pin Signal Description
1..25 Ground L Ground
26 FHOP_CLK Currently, not active, but reserved for future use of the corresponding sig-
nal.
27 FHOP_DATA | Currently, not active, but reserved for future use of the corresponding sig-
nal.
28 BURST_GATE | Currently, not active, but reserved for future use of the corresponding sig-
_A nal.
29 ..38 PARDATAOQ .. | Parallel data input/output 0...D with 10-bit word width for digital modulation.
PARDATAS If the data source "External Parallel" is selected, these pins are the data
inputs.
If a different data source is selected, the data is output here ("Custom Digi-
tal Modulation", Path A).
39 USER 3 USER input/output which can be configured for various purposes.
The following signals can be applied to the pin:
®  Marker 4 (output path A or path B)
e CW Mode Out (output path A or path B)
e FHOP_STRB (output path A or B)
This signal marks the trigger for frequency hopping by processing of
ARB sequences.
®  Trigger (output path A or path B)
This signal marks the trigger event caused by the selected trigger sig-
nal (internally or externally) of path A or B.
Additional signals for path B are available in two-path instruments. The
signals corresponding to path A are applied at the pins of the AUX I/O
interface (Clock Out).
®  Clock Out (output Path B; bit or symbol clock pulse)
This signal corresponds to the clock signal for digital modulations.
e |LEV ATT (input/output path B)
®  BURST (input/output path B)
40 USER 4 USER input/output which can be configured for various purposes.
41 BURST Signal output/input for controlling the burst ramp, path A.
With external envelope curve control ("Custom Digital Modulation" only),
the pin is the input for the control signal BURST_RAMP.
With internal envelope curve control, the control signal BURST_RAMP is
output for path A.
For two-path instruments, the signal for path B can be applied to one of the
user interfaces.
42 MARKER 3 A | Output for the freely programmable marker signal 3 of path A. The output is
permanently assigned.
43 MARKER 3 B | Output for the freely programmable marker signal 3 of Path B. The output is
permanently assigned.
44 LEV ATT Signal input/output for controlling the level attenuation.
For two-path instruments, the signal for Path B can be applied to one of the
USER interfaces.
With external envelope curve control ("Custom Digital Modulation" only),
the pin is the input for the control signal LEV_ATT.
With internal envelope curve control, the control signal LEV_ATT is output
for Path A.




BERT Connector

Pin Signal Description

45 FHOP_STRB | Currently not active, but reserved for future use of the signals

46 BURST_GATE | Currently not active, but reserved for future use of the signals
B

47 BITCLK Output Bit clock for internal mode.

For two-path instruments, the signal for Path B can be applied to one of the
USER interfaces.

48 USER 2 USER input/output which can be configured for various purposes.

49 SYMBCLK Symbol clock output for internal mode.

With two-path instruments, the signal for Path B can be applied to one of
the USER interfaces.

50 not used not used

A.3 Monitor Connector (MONITOR)

The 15-pin Sub-D female connector MONITOR at the rear panel is intended for con-
necting an external VGA monitor.

Table A-3: Pin assignment of the MONITOR connector

Monitor Connector Pin | Signal Pin | Signal Pin | Signal
1 Red (output) 6 GND 11 (NC)
2 Green (output) 7 GND 12 (NC)
3 Blue (output) 8 GND 13 HSYNC (output)
4 (NC) 9 GND 14 VSYNC (output)
5 GND 10 | GND 15 (NC)

A.4 BERT Connector

The 9-pin Sub-D connector BERT at the rear panel is available for the input signals of
the integrated bit error rate tester (option BER/BLE Measurement (R&S AMU-K80)).

Table A-4: Pin assignment of the BERT connector

Monitor Connector Pin | Signal Pin | Signal
1 GND 6 CLOCK
2 GND 7 DATA
3 GND 8 DATA ENABLE
4 GND 9 RESTART
5 GND




BERT Connector

The input signals are not terminated in the instrument. The impedance (50 ohm) and
the threshold (0.0128..1.998 V) of the inputs can be set in the "BERT" menu.

The following figure shows the circuit diagram of the BERT function.



BERT Connector
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